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Wprowadzenie 1
Zawarto  rozdzia u
• Opis ogólny: strona 1
• Pomoc techniczna: strona 3
• Urz dzenia obs ugiwane: strona 3 
• Korzystanie z tego podr cznika: strona 5
• Bezpiecze stwo u ytkownika: strona 6

Opis ogólny

Dzi kujemy za wybór firmy Medtronic Diabetes na swojego partnera 
w kierowaniu terapii cukrzycy u pacjentów. Jeste my przekonani, e
najnowocze niejsza technologia i prosty w obs udze interfejs u ytkownika 

oprogramowania CareLink™ Pro przynios  Pa stwu wiele korzy ci.

W niniejszym podr czniku u ytkownika opisano, w jaki sposób u ywa
oprogramowania CareLink Pro w celu pobierania, przechowywania 
danych diagnostycznych i dotycz cych leczenia oraz tworzenia raportów 
na ich podstawie. W podr czniku znajduje si  tak e opis opcji dost pu 
do pompy, glukometru oraz danych o st eniach glukozy zarejestrowanych 
przez czujnik i przes anych przez pacjentów do opartego na technologii 

Web systemu kierowania terapi  CareLink™ Personal wspó pracuj cego 
z oprogramowaniem CareLink Pro.
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Funkcje     

CareLink Pro jest oprogramowaniem do kontroli cukrzycy 
instalowanym na komputerze osobistym. Zawiera nast puj ce funkcje:

• Mo liwe jest tworzenie rekordów pacjenta w celu przechowywania 
danych pobranych z urz dzenia pacjenta oraz danych dotycz cych 
terapii z konta CareLink Personal pacjenta. 

• Dane pochodz ce z pomp insulinowych, monitorów i glukometrów 
mog  by  wysy ane do systemu, przechowywane, a nast pnie
wykorzystywane do tworzenia raportów.

• Mo liwe jest równie  opcjonalne po czenie z systemem CareLink 
Personal, co umo liwia dost p do przechowywanych przez pacjentów 
danych z urz dzenia. Najlepiej jest tworzy  aktualne raporty pomi dzy
wizytami u lekarza, dzi ki czemu w trakcie kolejnych wizyt odczyt 
danych z urz dzenia nie b dzie konieczny. 

• Z danych z urz dzenia przechowywanych w rekordzie pacjenta mo na
utworzy  ró ne raporty dotycz ce terapii. Dzi ki raportom znalezienie 
odpowiedzi na w tpliwo ci dotycz ce terapii zwi zane z zachowaniem 
pacjenta, schematami terapii i zastrze eniami jest atwiejsze.

• System zawiadamia o dost pnych aktualizacjach oprogramowania, 
które mog  zosta  pobrane i zainstalowane, co zapewnia dost p do 
najnowszych funkcji. 

• Funkcja Guide Me (Prowad  mnie) przeznaczona jest dla u ytkowników 
korzystaj cych z oprogramowania CareLink Pro po raz pierwszy. 
Dostarcza ona wskazówek i porad dotycz cych wykonywanych zada .

• Zintegrowany system pomocy wchodzi w sk ad oprogramowania, 
zapewniaj c informacje dotycz ce konkretnych obszarów zainteresowa .

Bezpiecze stwo     

• Oprogramowanie CareLink Pro mo e by  chronione has em.
• Transmisja danych pacjenta z systemu CareLink Personal jest szyfrowana 

przy u yciu zgodnej ze standardami bran y informatycznej technologii 
Secure Sockets Layer (SSL).

Dokumenty towarzysz ce     

Ka dy z nast puj cych dokumentów firmy Medtronic MiniMed zawiera 
informacje dotycz ce danego urz dzenia, które nie s  przedstawione 
szczegó owo w niniejszym podr czniku u ytkownika. 

UWAGA: Opis
glukometrów

innych firm znajduje
si w instrukcji

producenta do czonej
do glukometru.

• Podr cznik u ytkownika pompy insulinowej Paradigm
• Podr cznik u ytkownika monitora Guardian REAL-Time
• Podr cznik u ytkownika opisuj cy funkcje czujnika
• Podr cznik u ytkownika urz dzenia ComLink
• Podr cznik u ytkownika urz dzenia CareLink USB
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Pomoc techniczna

Je li konieczna jest dodatkowa pomoc dotycz ca tego systemu, nale y
si  skontaktowa  z lokalnym przedstawicielem firmy. Mi dzynarodowe 
informacje kontaktowe mo na uzyska  pod poni szym adresem URL:

http://www.medtronicdiabetes.com/help/contact/locations.html

UWAGA: Niektóre
urz dzenia obs ugiwane

przez niniejsze
oprogramowanie mog

nie by  dost pne we
wszystkich krajach,

w których zosta o ono
zatwierdzone do u ytku.

Urz dzenia obs ugiwane

Oprogramowanie CareLink Pro pobiera dane z nast puj cych urz dze .           

Pompy insulinowe/monitory st enia glukozy 

Pompy Medtronic MiniMed 508

Pompy z serii Medtronic 
MiniMed Paradigm 

511, 512, 712, 515, 715, 522, 722, 522K, 
722K, Paradigm® REAL-Time Revel™
(523, 723, 523K, 723K),
 Paradigm® Veo™ (554, 754)  

Monitor Guardian REAL-Time CSS-7100
CSS-7100K

Producent Glukometry     

Urz dzenia 
obs ugiwane przez firm
Medtronic Diabetes:

• Glukometr Bayer CONTOUR® LINK
• Glukometr LifeScan OneTouch® UltraLink™

• Monitor st enia glukozy we krwi 
BD Paradigm Link®

LifeScan:

• OneTouch® UltraSmart®

• OneTouch® Profile®

• OneTouch® Ultra®

• OneTouch® Basic®

• OneTouch® FastTake®

• OneTouch® SureStep®

• OneTouch® Ultra® 2
• OneTouch® UltraMini™

• OneTouch® UltraEasy®

Bayer:
• BREEZE™

• BREEZE™ 2
• CONTOUR®
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BD: • Logic®

Rodzina produktów Ascensia®

DEX® firmy Bayer, w cznie 
ze zgodnymi glukometrami:

• Ascensia® DEX®

• Ascensia® DEX® 2 
• Ascensia® DEXTER-Z® II
• Glucometer® DEXTER-Z®

• Ascensia® ESPRIT® 2 
• Glucometer® ESPRIT®

• Glucometer® ESPRIT® 2

Rodzina produktów 
Ascensia ELITE™ firmy Bayer, 
w cznie ze zgodnymi 
glukometrami:

• Ascensia ELITE™

• Glukometr ELITE® XL 

Abbott

• Precision Xtra™

• TheraSense FreeStyle®, FreeStyle Flash™

• FreeStyle Papillion™ Mini 
• FreeStyle Mini
• Optium Xceed™

• Precision Xceed™

Roche

• Accu-Chek® Aviva
• Accu-Chek® CompactPlus
• Accu-Chek® Compact
• Accu-Chek® Active

Urz dzenia komunikacyjne                 

 Com-Station, urz dzenie

Do u ytku z pomp  MiniMed 508 (szczegó owe 
informacje na temat wymaganego sprz tu 
znajduj  si  w podr czniku u ytkownika 
urz dzenia Com-Station).

ComLink, urz dzenie

Do u ytku z pomp  MiniMed Paradigm 
i monitorem Guardian REAL-Time 
(szczegó owe informacje na temat 
wymaganego sprz tu znajduj  si
w podr czniku u ytkownika urz dzenia 
ComLink). 

Monitor st enia glukozy we krwi 
Paradigm Link®

Do u ytku z pomp  MiniMed Paradigm 
i monitorem Guardian REAL-Time 
(szczegó owe informacje na temat 
wymaganego sprz tu znajduj  si
w podr czniku u ytkownika monitora 
st enia glukozy we krwi Paradigm Link®).

Urz dzenie CareLink™ USB
Do u ytku z pomp  MiniMed Paradigm 
i monitorem Guardian REAL-Time.

Kabel do transmisji danych
Do u ytku z glukometrami innych firm. 
Kabel do transmisji danych jest dostarczany 
przez wszystkich producentów glukometrów.

Producent Glukometry     
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Odpowiedniki       

Przy dodawaniu urz dzenia do systemu nale y wybra  jego mark
oraz model z listy. Je li marka i model nie znajduj  si  na li cie, nale y
znale  odpowiednik w poni szej tabeli.

UWAGA: Glukometry
mog  by  zamawiane
od ich producentów.

Zamawianie                       

Aby zamówi  produkty firmy Medtronic Diabetes, nale y skontaktowa
si  z jej lokalnym przedstawicielem. Mi dzynarodowe informacje 
kontaktowe mo na uzyska  pod poni szym adresem URL:

http://www.medtronicdiabetes.com/help/contact/locations.html

Korzystanie z tego podr cznika

Definicje terminów i funkcji zawarte s  w S owniku. W poni szej tabeli 
przedstawiono konwencje stosowane w tym podr czniku.

W podr czniku u ytkownika przedstawiono przyk adowe kopie 
ekranów oprogramowania. Rzeczywisty wygl d wy wietlanych 
ekranów oprogramowania mo e si  nieznacznie ró ni  od 
przedstawionych w podr czniku.

Urz dzenie u ywane przez pacjenta Odpowiednik

• Ascensia® DEX® firmy Bayer
• Ascensia® DEX® 2 firmy Bayer
• Ascensia® DEXTER-Z® II firmy Bayer
• Glucometer® DEXTER-Z® firmy Bayer
• Ascensia® ESPRIT® 2  firmy Bayer
• Glucometer® ESPRIT® firmy Bayer
• Glucometer® ESPRIT® 2 firmy Bayer

Ascensia® DEX® firmy Bayer 

Glukometr ELITE® XL firmy Bayer Ascensia ELITE™ XL firmy Bayer 

Precision Xceed™ Optium Xceed™

Termin/format Znaczenie

Nacisn nacisn  lewy przycisk myszy, aby wybra  dany obiekt 
na ekranie 

Nacisn  dwukrotnie nacisn  dwukrotnie lewy przycisk myszy, aby otworzy
wybrany obiekt na ekranie

Nacisn  prawym 
przyciskiem myszy

nacisn  prawym przyciskiem myszy wybrany obiekt na 
ekranie, aby wy wietli  inne okno lub menu

Tekst pogrubiony u ywany w przypadku opcji lub cie ki menu. Na przyk ad: 
Patient > New Patient (Pacjent > Nowy pacjent)

Tekst pisany WIELKIMI 
LITERAMI

u ywany w przypadku przycisków. 
Na przyk ad: przycisk SAVE (Zapisz)
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Bezpiecze stwo u ytkownika

Wskazania 

System CareLink Pro jest przeznaczony do u ycia jako narz dzie
pomocne w kontroli cukrzycy. System umo liwia pobieranie informacji 
przesy anych z pomp insulinowych, glukometrów oraz systemów 
ci g ego monitorowania st enia glukozy i do sporz dzania na ich 
podstawie raportów CareLink Pro. Raporty dostarczaj  informacji 
przydatnych w identyfikacji trendów i ledzeniu dziennych aktywno ci,
takich jak spo ycie w glowodanów, czas posi ków, podawanie insuliny 
oraz odczyty st enia glukozy. 

Ostrze enia 

• System jest przeznaczony do u ycia przez lekarza specjalist
z praktyk  w zakresie kontroli cukrzycy. 

• Wyniki uzyskiwane przez system nie udost pniaj adnych informacji 
o charakterze porady lekarskiej i nie mog  by  traktowane jako ród o
takich informacji. 

• Niniejszy produkt powinien by  u ywany wy cznie z obs ugiwanymi 
urz dzeniami wymienionymi w niniejszym podr czniku (patrz 
Urz dzenia obs ugiwane, na stronie 3).

• Nale y zaleci  pacjentom sprawdzanie poziomu glukozy we krwi co 
najmniej 4–6 razy dziennie.

• Pacjenci nie powinni wprowadza adnych zmian w leczeniu bez 
konsultacji z lekarzem specjalist .

• Decyzje o leczeniu pacjenci powinni podejmowa  w oparciu 
o wskazówki lekarza oraz wyniki st enia glukozy zmierzone 
glukometrem, a nie przy u yciu czujnika glukozy.

Kursywa format u ywany w przypadku nazw ekranów i pól. 
Na przyk ad: Ekran Reports (Raporty)

UWAGA: dodatkowe informacje

PRZESTROGA: ostrzega o zagro eniu, które, je li nie zostanie za egnane, 
mo e spowodowa  niewielkie lub umiarkowane 
uszkodzenia oprogramowania lub sprz tu.

OSTRZE ENIE: informuje o potencjalnym niebezpiecze stwie, które, je li 
nie zostanie za egnane, mo e spowodowa mier  lub 
powa ne obra enia. Mo e równie  opisywa  potencjalne 
powa ne reakcje niepo dane i zagro enia.

Termin/format Znaczenie
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Przeciwwskazania

Oprogramowania nie nale y u ywa  z urz dzeniami innymi ni
wymienione w cz ci Urz dzenia obs ugiwane, na stronie 3. Ponadto 
nie nale y u ywa  tego produktu w terapii schorze  innych ni  cukrzyca.

Przed otwarciem oprogramowania nale y zamkn  nast puj ce
programy, je li s  aktualnie uruchomione na komputerze:

• Oprogramowanie CGMS® System Solutions™

• Oprogramowanie pomp i glukometrów Solutions®

• Oprogramowania Guardian® Solutions®

• Oprogramowanie ParadigmPAL™

• CareLink™ Personal 

• Oprogramowanie Solutions® do systemu CGMS® iPro
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Nawigacja systemu 2
Zawarto  rozdzia u
• Opis ogólny: strona 8
• Otwieranie CareLink Pro: strona 8
• Obszary robocze: strona 10
• Pasek g ównego menu: strona 12
• Pasek narz dzi: strona 12
• Funkcja Guide Me (Prowad  mnie): strona 13
• cza Learn More (Dowiedz si  wi cej): strona 14
• System pomocy: strona 14

Opis ogólny

W tym rozdziale mo na zapozna  si  ze rodowiskiem graficznym (GUI) 

oprogramowania CareLink™ Pro. W jego sk ad wchodz  ekrany menu, paski 
narz dzi i nawigacji, obszary robocze i okno Guide Me (Prowad  mnie). 

Otwieranie CareLink Pro

1 Nacisn  dwukrotnie ikon  CareLink Pro na pulpicie komputera.

Je li w klinice wymagane jest wprowadzanie has a, wy wietlany jest 
ekran rejestracyjny.

 Ikona CareLink Pro
wy wietlana na

pulpicie
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a. Wpisa  has o w pole Password (Has o).

UWAGA: Funkcj
rejestracji po wpisaniu

has a mo na ustawi
opcjonalnie podczas

procesu instalacji.

b. Nacisn  przycisk LOGIN (Rejestruj).

Wy wietlony zostaje ekran rozpoczynania.

2 Aby utworzy  nowy rekord pacjenta, nale y nacisn  przycisk NEW 
PATIENT (Nowy pacjent). Aby otworzy  rekord pacjenta z listy 
pacjentów w systemie, nacisn  przycisk OPEN PATIENT (Otwórz 
rekord pacjenta).

        

G ówne menu

Aktywny obszar 
roboczy

Dost p do listy pacjentówDodawanie nowego pacjenta

Pasek nawigacyjny

Pasek stanu

Przycisk Reports (Raporty)
w obszarze roboczym

Przycisk Devices
(Urz dzenia) w obszarze

roboczym
Przycisk Profile (Profil)
w obszarze roboczym

Wy wietlanie/ukrywanie okna 
Guide Me (Prowad  mnie)
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Obszary robocze

UWAGA: Szczegó owe
informacje na temat

obszarów roboczych
i sposobów korzystania

z nich znajduj  si
w innych rozdzia ach.

Je li rekord pacjenta jest otwarty mo na nacisn  jeden z przycisków 
na pasku nawigacyjnym, aby wy wietli  odpowiedni obszar roboczy. 
Z obszarów roboczych nale y korzysta  w celu wprowadzania lub 
wyboru informacji potrzebnych do realizacji zada  w systemie CareLink 
Pro dotycz cych danego pacjenta.

• Profile (Profil): umo liwia przechowywanie informacji o pacjencie 
takich jak imi  i nazwisko, czy data urodzenia. Z tego obszaru roboczego 
mo na równie  po czy  si  z kontem CareLink Personal pacjenta.

• Devices (Urz dzenia): pozwala na przechowywanie informacji 
koniecznych do odczytu danych z urz dzenia pacjenta.

• Reports (Raporty): umo liwia wybór parametrów i raportów, które 
s tworzone dla pacjenta.

Do momentu dodania i zapisania profilu pacjenta dost pny jest 
wy cznie obszar roboczy Profile (Profil). Do czasu dodania urz dze
pacjenta ma on dost p jedynie do obszarów roboczych Profile (Profil) 
oraz Devices (Urz dzenia).
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Obszary robocze

Obszar roboczy Devices (Urz dzenia)

Obszar roboczy Profile (Profil)

Obszar roboczy Reports (Raporty)

Profile 
(Profil)

Devices
(Urz dzenia)

Reports 
(Raporty)
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Pasek g ównego menu

Poni ej przedstawiono opcje dost pne w menu g ównym. Dost p do 
niektórych z nich mo na równie  uzyska  za pomoc  skrótów klawiszowych 
podanych obok opcji menu, np. Ctrl+N jak New Patient (Nowy pacjent). 
Z niektórych opcji menu mo na równie  skorzysta , korzystaj c
z paska nawigacji lub narz dzi.

Pasek narz dzi

Pasek narz dzi programu CareLink Pro umo liwia szybki dost p do cz sto
u ywanych funkcji. Na pasku narz dzi wy wietlane s  nast puj ce przyciski.

Przycisk Nazwa Funkcja

Add Patient 
(Dodaj pacjenta)

Otwiera obszar roboczy Profile (Profil), 
umo liwiaj c dodawanie nowego rekordu 
pacjenta do systemu.

Open Patient 
(Otwórz rekord 
pacjenta)

Otwiera tabel  Patient Lookup 
(Wyszukiwanie pacjenta), w której mo na 
wybra  istniej cy rekord pacjenta do 
wy wietlenia.

Guide Me 
(Prowad  mnie)

Wy wietla lub chowa okno Guide Me 
(Prowad  mnie). Nacisn , aby uzyska
dostosowane do kontekstu wskazówki 
systemu. 
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Zak adki pacjentów

Po otwarciu rekordu pacjenta wzd u  paska narz dzi wy wietlana jest 
zak adka z imieniem i nazwiskiem pacjenta. Aktywna zak adka oznacza, e
rekord pacjenta i obszar roboczy s  aktywne oraz mo liwe jest przeprowadzanie 
zada  oprogramowania CareLink Pro dotycz cych pacjenta.

Rekord pacjenta mo na aktywowa , naciskaj c na zak adk  pacjenta. 
Aby zamkn  rekord, nale y nacisn  przycisk CLOSE (Zamknij) na 
zak adce pacjenta.

Funkcja Guide Me (Prowad  mnie)

Funkcja Guide Me (Prowad  mnie) jest dost pna w ca ym programie 
CareLink Pro. Jej wybór powoduje otworzenie dostosowanych do 
kontekstu wskazówek i porad dotycz cych dzia a , które mog  zosta
podj te w aktywnej cz ci systemu. Okna Guide Me (Prowad  mnie) 
mog  równie  zawiera cza >> learn more (dowiedz si  wi cej).
Po ich naci ni ciu otwiera si  odpowiednia sekcja pomocy online 
ze szczegó owymi informacjami na dany temat. Funkcja Guide Me 
(Prowad  mnie) jest domy lnie w czona. Mo na j  jednak wy czy
w dowolnym momencie.

Przycisk CLOSE 
(Zamknij) 

Nieaktywna zak adka Aktywna zak adka

Przycisk Close
(Zamknij)
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W czanie i wy czanie funkcji Guide Me (Prowad  mnie) 

Za pomoc  przycisku

• Nacisn  przycisk GUIDE ME (Prowad  mnie), aby w czy  lub 
wy czy  t  funkcj .

Przy u yciu menu 

• Wybra  opcje Help > Guide Me (Pomoc > Prowad  mnie), 
aby zaznaczy  lub usun  zaznaczenie funkcji.

cza Learn More (Dowiedz si  wi cej)

cza Learn More (Dowiedz si  wi cej) pozwalaj  otworzy  odpowiednie 
zagadnienie w systemie pomocy online. cza s  dost pne w ca ym 
systemie, w oknach Guide Me (Prowad  mnie) lub w oprogramowaniu. 

cze >> learn more (dowiedz si  wi cej) nale y nacisn  w przypadku 
braku pewno ci, jak dalej post powa  i jakie warto ci wprowadzi .

System pomocy

System pomocy zapewnia wsparcie podczas korzystania 
z oprogramowania CareLink Pro, dostarczaj c informacji o sposobie 
przeprowadzania zada  oprogramowania. 

Aby uzyska  dost p do systemu pomocy, nale y wykona  jedn
z nast puj cych czynno ci:

• Wybra  polecenie Help > Medtronic CareLink Pro Help 
(Pomoc > Pomoc oprogramowania Medtronic CareLink Pro). 

• Nacisn  klawisz F1.

Przycisk Guide Me
(Prowad  mnie)

cze learn more 
(dowiedz si  wi cej)
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Pocz tek pracy 3
Zawarto  rozdzia u
• Przed rozpocz ciem: strona 15
• Otworzenie i zamkni cie rekordów pacjenta: strona 17
• Ustawianie preferencji systemowych: strona 18 

W tym rozdziale znajduj  si  wskazówki dotycz ce uruchamiania 

oprogramowania CareLink™ Pro, otwierania i zamykania rekordów 
pacjenta oraz ustawiania preferencji odnosz cych si  do wszystkich 
pacjentów w systemie. 

Przed rozpocz ciem

Je eli u ytkownik u ywa oprogramowania CareLink Pro po raz 
pierwszy, powinien si  upewni , e ustawione s  preferencje na karcie 
General (Ogólne, patrz Preferencje na karcie General (Ogólne), na 
stronie 18). Preferencje te okre laj  sposób wy wietlania pewnych 
elementów w oprogramowaniu i w raportach, a tak e sposób 
komunikacji systemu z internetem.

Preferencje mo na ustawi  w dowolnej chwili. Warto rozwa y
od o enie ustawienia innych preferencji do czasu zaznajomienia 
si z oprogramowaniem CareLink Pro.
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G ówne zadania systemu

W poni szej tabeli opisano pokrótce g ówne zadania, których 
wykonanie mo e by  po dane podczas wst pnej konfiguracji 
i pierwszego u ycia oprogramowania CareLink Pro. Znajduj  si
w niej równie  informacje na temat cz ci niniejszego podr cznika
u ytkownika, w których opisano poszczególne zadania.

Krok Lokalizacja

Zapoznanie si  z interfejsem 
u ytkownika oprogramowania 
CareLink Pro.

Rozdzia 2, Nawigacja systemu

Zdefiniowanie opcji systemu, które b d
wykorzystywane globalnie w danym 
zak adzie opieki zdrowotnej.

Ustawianie preferencji systemowych, 
na stronie 18

Utworzenie profilów wszystkich pacjentów. Dodawanie nowych profilów, 
na stronie 25

Utworzenie po cze  z kontami pacjentów 
w programie CareLink Personal.

Tworzenie po cze  z kontami 
programu CareLink Personal 
(opcjonalne), na stronie 26

Dodanie pompy i glukometrów pacjenta 
do jego profilu. Dodawanie urz dzenia, na stronie 35

Odczyt danych z pompy i glukometrów 
pacjenta.

Odczytywanie danych z urz dzenia, 
na stronie 41

Konfiguracja i tworzenie raportów dla 
poszczególnych pacjentów.

Tworzenie raportów, na stronie 45

Regularne tworzenie kopii zapasowych 
bazy danych systemu CareLink Pro.

Tworzenie kopii zapasowej bazy 
danych, na stronie 59

Aktualizowanie oprogramowania 
CareLink Pro.

Stosowanie aktualizacji 
oprogramowania, na stronie 58
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Otworzenie i zamkni cie rekordów pacjenta

Otworzenie rekordów pacjenta         

Jednorazowo mo na utworzy  maksymalnie sze  rekordów pacjenta. 
Je eli nie zosta y jeszcze utworzone adne profile pacjentów, patrz 
Dodawanie nowych profilów, na stronie 25.

1 Wybra  opcj File > Open Patient (Plik > Otwórz rekord pacjenta) lub 
nacisn  przycisk OPEN PATIENT (Otwórz rekord pacjenta). Zostanie 
wy wietlona lista pacjentów podobna do przedstawionej poni ej.

UWAGA: W przypadku
wy wietlenia

komunikatu o zbyt du ej
liczbie otwartych

rekordów pacjenta
nale y nacisn

przycisk OK, zamkn
rekord i kontynuowa .

2 Znale  pacjenta na li cie poprzez wpisanie imienia lub nazwiska pacjenta 
w polu Find a Patient (Znajd  pacjenta). Gdy pacjent zostanie pod wietlony 
na li cie, nacisn  przycisk OPEN (Otwórz), a nast pnie dwukrotnie 
nacisn  pozycj  na li cie lub przycisk ENTER. Po li cie mo na porusza
si  równie  za pomoc  strza ek w gór  i w dó  na klawiaturze. 

Wy wietlany jest obszar roboczy Devices (Urz dzenia, je eli
urz dzenia nie zosta y jeszcze dodane) lub Reports (Raporty) pacjenta.

3 Aby obejrze  obszar roboczy Profile (Profil) pacjenta, nacisn  przycisk 
PROFILE (Profil) na pasku nawigacyjnym.

Zamykanie rekordów pacjenta        

1 Upewni  si , e rekord pacjenta, który ma zosta  zamkni ty, jest aktywny 
(zak adka jest pod wietlona).

2 Wykona  jedn  z poni szych czynno ci:
a. Wybra  opcj File > Close Patient (Plik > Zamknij rekord pacjenta).
b. Nacisn  przycisk CLOSE (Zamknij) na zak adce pacjenta.
c. Nacisn  klawisze Ctrl+F4.

Przycisk Open
Patient

(Otwórz rekord
pacjenta)

Przycisk Profile (Profil)

Przycisk Close (Zamknij)
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Ustawianie preferencji systemowych

Te preferencje odnosz  si  do wszystkich pacjentów w systemie. Aby 
dowiedzie  si  wi cej na temat preferencji odnosz cych si  do poszczególnych 
pacjentów, patrz Sprawdzanie ustawie  raportów, na stronie 49.

Preferencje s  wy wietlane w nast puj cych grupach:

• General (Ogólne)
– Glucose units (Jednostki glukozy)
– Carbohydrate units (Jednostki w glowodanowe)
– Communications (Komunikacja)
– Troubleshooting (Rozwi zywanie problemów)

• Patient Profile (Profil pacjenta)
– Mo na tu wybra  i u o y  pola danych w profilach pacjenta.

• Patient Lookup (Wyszukiwanie pacjenta)
– S u y do modyfikacji i zmiany kolejno ci wy wietlania pól po 

wybraniu opcji Open Patient (Otwórz rekord pacjenta) w celu 
obejrzenia listy pacjentów.

• Report Generation (Tworzenie raportu)
– Mo na tu wybra  pola danych, które maj  by  wy wietlane po 

wybraniu wype nienia raportu Daily Detail (Szczegó y z dnia) 
z tabeli Data (Dane).

Preferencje na karcie General (Ogólne)  

1 Wybra  opcj Tools > Options (Narz dzia > Opcje). Wy wietlone
zostanie nast puj ce okno.
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2 Nacisn  przycisk opcji po danej warto ci:

– Glucose Units (Jednostki glukozy): mg/dl lub mmol/l
– Carbohydrate Units (Jednostki w glowodanowe): grams (gramy) 

lub Exchanges (Wymienniki)
a. W przypadku wybrania przycisku Exchanges (Wymienniki) dla 

opcji Carbohydrate Units (Jednostki w glowodanowe) nale y
wpisa  odpowiedni  liczb  w polu grams are equal to 1 Exchange 
(gramów równa si  1 wymiennikowi).

3 W przypadku opcji z sekcji Communications (Komunikacja) nale y
zaznaczy  (w czy ) lub odznaczy  (wy czy ) odpowiednie pole 
wyboru:

UWAGA: Podczas
ustawiania preferencji

dotycz cych
komunikacji nale y

post powa  zgodnie
z wytycznymi kliniki lub
dzia u informatycznego.

– Automatically check for software updates (Automatycznie 
wyszukuj aktualizacje oprogramowania): je eli to pole jest 
zaznaczone, do ka dego dzia aj cego systemu z oprogramowaniem 
CareLink Pro zostanie wys ane powiadomienie, gdy dost pna b dzie
aktualizacja oprogramowania. Aktywny u ytkownik b dzie mia
wówczas mo liwo  pobrania i instalacji aktualizacji. Aby tak si
nie dzia o, a aktualizacje oprogramowania by y rozprowadzane 
w sposób kontrolowany, mo na odznaczy  to pole wyboru.

– Synchronize with (Synchronizuj z) CareLink™ Personal: Je eli
system ma dokonywa  automatycznej synchronizacji z danymi 
CareLink Personal pacjenta za ka dym razem, gdy otwierany 
jest profil danego pacjenta, nale y zaznaczy  pole wyboru 
Synchronize with CareLink Personal (Synchronizuj z CareLink 
Personal). Je eli to pole wyboru zostanie odznaczone, dla 
ka dego pacjenta b dzie wymagana r czna synchronizacja 
z danymi CareLink Personal.

4 Nacisn  w celu wybrania lub odznaczy  pole wyboru w sekcji 
Troubleshooting (Rozwi zywanie problemów). Je eli to pole wyboru 
jest zaznaczone, aplikacja zapisze odczyty urz dzenia w celu 
rozwi zywania problemów.

5 Nacisn  przycisk OK w celu zapisania preferencji na karcie 
General (Ogólne). 
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Preferencje profilów pacjenta         

1 Wybra  opcj Tools > Options (Narz dzia > Opcje). 

2 Nacisn  zak adk Patient Profile (Profil pacjenta). Wy wietlone 
zostanie nast puj ce okno.

Wybieranie pól danych  

1 Za pomoc  pól wyboru doda  po dane pola.

UWAGA: Nie mo na
usun  pól First Name

(Imi ) i Last Name
(Nazwisko).

2 Aby usun  pole z profilu, nale y odznaczy  jego pole wyboru.

3 Aby uczyni  pole wymaganym, nale y zaznaczy  pole wyboru 
w kolumnie Required (Wymagane). Pole wymagane musi zosta
wype nione przed utworzeniem profilu.

Dodawanie pola niestandardowego         

1 Zaznaczy  pole wyboru na lewo od pustego pola niestandardowego.

2 Wprowadzi  tekst w celu nazwania pola (np. Kontakt w nag ym 
wypadku). Ta nazwa pola b dzie wy wietlana w profilu pacjenta.

3 Aby uczyni  pole wymaganym, nale y zaznaczy  pole wyboru 
w kolumnie Required (Wymagane).

Za pomoc  pól wyboru wybra  pola, które maj  wyst powa  w profilu. Za pomoc
strza ek w gór  i w dó  ustawi  pola w odpowiedniej kolejno ci.
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UWAGA: Aby usun
pole niestandardowe

z profilu, nale y
odznaczy  pole wyboru

obok pola (pól), które
ma zosta  usuni te.

Zmiana kolejno ci pól danych         

• Wybra  pole, które ma zosta  przesuni te, a nast pnie nacisn
strza k  w gór  lub w dó  w celu przesuni cia pola. (Strza ki na górze 
i na dole przesuwaj  pole na sam  gór  lub na sam dó  listy). 

Ko czenie ustawiania preferencji profilu pacjenta

• Gdy na li cie Field Order (Kolejno  pól) wyst puj  wszystkie 
po dane pola w odpowiedniej kolejno ci, nacisn  przycisk OK.

Profile pacjenta posiadaj  teraz w a nie wybrane pola w odpowiedniej 
kolejno ci.

Preferencje na karcie Patient Lookup (Wyszukiwanie pacjenta)         

1 Wybra  opcj Tools > Options (Narz dzia > Opcje). 

2 Nacisn  zak adk Patient Lookup (Wyszukiwanie pacjenta). 
Wy wietlane zostanie nast puj ce okno.

Wybieranie danych do wy wietlenia  

• Za pomoc  pól wyboru wybra  dane, które maj  by  wy wietlane lub 
usun  dane, które nie maj  by  wy wietlane w tabeli Patient Lookup 
(Wyszukiwanie pacjenta).

Strza ki w gór
 i w dó

Za pomoc  pól wyboru wybra  dane, które maj  wyst powa  w tabeli Patient Lookup 
(Wyszukiwanie pacjenta). Za pomoc  strza ek w gór  i w dó  ustawi  kolumny 
w odpowiedniej kolejno ci.
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UWAGA: Nie mo na
usun  pól First Name

(Imi ) i Last Name
(Nazwisko).

Zmiana kolejno ci kolumn

• Aby zmieni  kolejno  kolumn w tabeli Patient Lookup (Wyszukiwanie 
pacjenta), nale y wybra  kolumn  do przesuni cia i nacisn  strza ki
w gór  lub w dó . (Strza ki na górze i na dole przesuwaj  kolumn
danych na sam  gór  lub na sam dó  listy).

UWAGA: Kolumna
danych na górze listy

Column Display
Order (Kolejno

wy wietlania kolumn)
jest wy wietlana

w pierwszej kolumnie
tabeli Patient Lookup

(Wyszukiwanie
pacjenta). Kolumna
danych na dole jest

wy wietlana w ostatniej
kolumnie tabeli.

Ko czenie ustawiania preferencji wyszukiwania pacjenta

• Gdy na li cie Column Display Order (Kolejno  wy wietlania kolumn) 
wyst puj  wszystkie po dane dane w odpowiedniej kolejno ci, 
nacisn  przycisk OK.

Tabela Patient Lookup (Wyszukiwanie pacjenta) zawiera teraz 
wszystkie wybrane dane i kolejno  kolumn.

Preferencje na karcie Report Generation (Tworzenie raportu)  

Tabela danych jest wy wietlana na etapie wybierania w procesie 
tworzenia raportu. Ta tabela powinna zawiera  dane najbardziej 
pomocne dla pracowników s u by zdrowia w okre laniu dni, dla których 
chc  oni zobaczy  raporty zawieraj ce szczegó y.

UWAGA: Informacje na
temat sposobu, w jaki te
preferencje odnosz  si

do Tabeli danych
podczas tworzenia

raportu mo na znale
w cz ci Wybór rodzajów

raportów i dat do
przedstawienia

w raporcie, na stronie 51.

1 Wybra  opcj Tools > Options (Narz dzia > Opcje). 

2 Nacisn  zak adk Report Generation (Tworzenie raportu). 
Wy wietlone zostanie nast puj ce okno.

Strza ki w gór
 i w dó

Za pomoc  pól wyboru wybra  rodzaj danych, który ma wyst powa  w Tabeli danych. 
Za pomoc  strza ek w gór  i w dó  ustawi  kolumny w odpowiedniej kolejno ci.



Podr cznik u ytkownika oprogramowania CareLink™ Pro    Pocz tek pracy      23

Wybieranie danych do wy wietlenia        

• Za pomoc  pól wyboru wybra  dane, które maj  by  wy wietlane lub 
usun  dane, które nie maj  by  wy wietlane w Tabeli danych.

Zmiana kolejno ci kolumn         

• Aby zmieni  kolejno  kolumn w Tabeli danych, nale y wybra
kolumn  do przesuni cia i nacisn  strza k  w gór  lub w dó . (Strza ki 
na górze i na dole przesuwaj  kolumn  danych na sam  gór  lub na 
sam dó  listy.)

UWAGA: Elementy na
li cie Column Order
(Kolejno  kolumn)

s wy wietlane
w pierwszej kolumnie

Tabeli danych.
Elementy na dole s

wy wietlane w ostatniej
kolumnie Tabeli danych.

Ko czenie ustawiania preferencji tworzenia raportu

• Gdy na li cie Column Order (Kolejno  kolumn) wyst puj  wszystkie 
po dane dane w odpowiedniej kolejno ci, nacisn  przycisk OK. 

Tabela danych zawiera teraz wszystkie wybrane dane i kolejno  kolumn.

Strza ki w gór
 i w dó
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Obszar roboczy Profile 
(Profil) 4
Zawarto  rozdzia u
• Przed rozpocz ciem: strona 24
• Dodawanie nowych profilów: strona 25
• Edycja profilów pacjenta: strona 25
• Usuwanie pacjenta z systemu: strona 25
• Tworzenie po cze  z kontami programu CareLink Personal 

(opcjonalne): strona 26

Profil jest podobny do ok adki karty medycznej. Zawiera on dane takie 
jak nazwisko i data urodzenia. Profil jest wymagany, zanim dane 
urz dzenia zostan  zebrane i u yte do utworzenia raportów z terapii.

Obszar roboczy Profile (Profil) umo liwia równie  utworzenie po czenia 
z kontem pacjenta w programie CareLink Personal. Po utworzeniu 
po czenia mo na uzyska  dane pacjenta przechowywane w programie 
CareLink Personal w dowolnej chwili — obecno  pacjenta nie jest 
konieczna.

Przed rozpocz ciem

Po dane mo e by  dostosowanie profilów pacjentów w taki sposób, 
aby zawiera y one wy cznie ten rodzaj informacji, który ma zosta
pobierany. Wi cej informacji na ten temat mo na znale  w cz ci
Preferencje profilów pacjenta, na stronie 20.

Podczas ustawiania po czenia z kontem pacjenta w programie 
CareLink Personal jest równie  wymagana nazwa u ytkownika i has o. 
Pacjent musi by  obecny w celu podania tych danych.
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Dodawanie nowych profilów

Za ka dym razem gdy do systemu CareLink Pro dodawany jest 
pacjent, nale y zacz  od utworzenia profilu dla tego pacjenta. 

1 Wybra  opcj File > New Patient (Plik > Nowy pacjent) lub nacisn
przycisk ADD PATIENT (Dodaj pacjenta). 

Wy wietlany jest obszar roboczy Profile (Profil, patrz przyk ad, strona 11). 

UWAGA: Aby doda  lub
zmieni  pola w profilu

pacjenta, nale y
wybra opcj

>> customize fields
(dopasuj pola). Patrz

Preferencje profilów
pacjenta, na stronie 20.

2 Wype ni  pola w sekcji Patient Profile (Profil pacjenta). 

3 Nacisn  przycisk SAVE (Zapisz).

Nowy pacjent zosta  dodany do bazy danych oprogramowania 
CareLink Pro. Wy wietlany jest komunikat potwierdzaj cy zapisanie 
profilu.

Je eli pole wymagane nie jest wype nione w momencie zapisywania 
profilu pacjenta, obok tego pola jest wy wietlany komunikat. Nie b dzie 
mo na zapisa  profilu, dopóki w tym polu nie zostanie dokonany wpis.

Edycja profilów pacjenta

1 Upewni  si , e obszar roboczy Profile (Profil) jest otwarty.

2 Nacisn  przycisk EDIT (Edycja).

3 Edytowa  dane w sekcji Patient Profile (Profil pacjenta) zgodnie 
z wymaganiami.

4 Nacisn  przycisk SAVE (Zapisz).

Wy wietlany jest komunikat potwierdzaj cy zapisanie profilu.

Usuwanie pacjenta z systemu

1 Upewni  si , e obszar roboczy Profile (Profil) jest otwarty. 

2 Sprawdzi , czy jest to pacjent, który ma zosta  usuni ty. Usuni cie 
profilu pacjenta usuwa równie  wszystkie dane pacjenta z bazy 
danych oprogramowania CareLink Pro i nie mo na tego cofn .

3 Nacisn  opcj >> delete patient record (usu  rekord pacjenta) 
nad sekcj  synchronizacji profilu.

Wy wietlany jest komunikat ostrzegaj cy, e wszystkie dane pacjenta 
zostan  skasowane po usuni ciu rekordu. 

4 Nacisn  przycisk YES (Tak) w celu usuni cia rekordu pacjenta.

Przycisk Add Patient
(Dodaj pacjenta)
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Tworzenie po cze  z kontami programu CareLink 
Personal (opcjonalne)

Je eli pacjent wyrazi na to zgod , mo na ustawi  po czenie z kontem 
pacjenta w programie CareLink Personal. To oparte na technologii 
sieciowej narz dzie umo liwia przesy anie i przechowywanie danych 
uzyskanych z urz dzenia i uruchamianie ró nych raportów z terapii. 

Po po czeniu z kontem pacjenta w programie CareLink Personal mo na 
pobiera  dane urz dzenia, które s  tam przechowywane w celu 
wykorzystania podczas generowania raportów programu CareLink Pro. 
Raporty mo na generowa  w dowolnej chwili, nawet mi dzy wizytami. 
Eliminuje to równie  potrzeb  odczytywania danych z urz dzenia 
pacjenta podczas jego wizyt w gabinecie.

Je eli pacjent nie posiada jeszcze konta w programie CareLink Personal, 
mo na wys a  wiadomo  e-mail z zaproszeniem do jego za o enia. 

Tworzenie po czenia z istniej cym kontem  

UWAGA: Pacjent musi
by  obecny w celu

wykonania opisanych
czynno ci.

1 Upewni  si , e komputer jest pod czony do internetu.
2 Otworzy  obszar roboczy Profile (Profil) pacjenta. 
3 Upewni  si , e wszystkie pola wymagane w sekcji Patient Profile 

(Profil pacjenta) s  wype nione.
4 Nacisn  opcj  LINK TO EXISTING ACCOUNT (Po cz z istniej cym 

kontem). 
Wy wietlany jest ekran Log In (Logowanie) programu CareLink Personal.

5 Pacjent powinien wykona  nast puj ce czynno ci:
a. Wpisa  swoj  nazw  u ytkownika (Username) i has o (Password).
b. Nacisn  przycisk SIGN IN (Zaloguj). 
Wy wietlona zostanie strona Grant Access (Udziel dost pu) w oparciu 
o ustawienia j zykowe i regionalne dla pacjenta.



Podr cznik u ytkownika oprogramowania CareLink™ Pro    Obszar roboczy Profile (Profil)      27

6 Pacjent powinien wykona  nast puj ce czynno ci:

a. Przeczyta  cz  Terms of Use (Warunki u ytkowania).
b. Nacisn  pole wyboru obok napisu I agree to the Terms of Use 

above… (Akceptuj  na warunki u ytkowania opisane powy ej…)
c. Nacisn  przycisk GRANT ACCESS (Udziel dost pu).
d. Powiadomi  o wy wietleniu strony z podzi kowaniami Thank You.
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Mo na wydrukowa  cz  Terms of Use (Warunki u ytkowania) dla 
pacjenta, naciskaj c przycisk PRINT (Drukuj).

Uzyskano po czenie z kontem pacjenta w programie CareLink Personal. 
Patrz Pobieranie danych z konta z po czeniem, na stronie 29.

Wysy anie wiadomo ci e-mail z zaproszeniem           

Aby wys a  wiadomo  e-mail z zaproszeniem dla pacjenta do utworzenia 
konta w programie CareLink Personal, nale y wykona  poni sze czynno ci:

1 Otworzy  obszar roboczy Profile (Profil) pacjenta. 

2 Upewni  si , e wszystkie pola wymagane w sekcji Patient Profile 
(Profil pacjenta) s  wype nione.

3 Nacisn  przycisk SEND E-MAIL INVITATION TO PATIENT 
(Wy lij zaproszenie e-mail do pacjenta).

4 Upewni  si , e pola Patient Name (Nazwisko pacjenta), 
Email i Language (J zyk) s  prawid owo wype nione.

5 Nacisn  przycisk SEND (Wy lij). 

W obszarze statusu profilu pacjenta wy wietlone zostanie potwierdzenie 
wys ania wiadomo ci e-mail.

Usuwanie po czenia z kontem programu CareLink Personal 
z oprogramowania CareLink Pro

Mo na usun  po czenie z kontem programu CareLink Personal 
z oprogramowania CareLink Pro. Ta opcja jest dost pna jedynie po 
utworzeniu po czenia do konta pacjenta. Powoduje ona przerwanie 
pobierania danych przez oprogramowanie CareLink Pro z konta pacjenta 
w programie CareLink Personal. Nie ma ona wp ywu na osobiste 
korzystanie z konta programu CareLink Personal przez pacjenta.
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1 Otworzy  rekord pacjenta i uzyska  dost p do obszaru roboczego 
Profile (Profil).

2 Nacisn  przycisk UNLINK ACCOUNT (Usu  po czenie z kontem).

3 Nacisn  przycisk Yes (Tak) w komunikacie z potwierdzeniem. Nie 
wyst puje ju  po czenie pomi dzy profilem osobistym pacjenta 
a oprogramowaniem CareLink Pro.

Stan zmienia si  na „Not linked” (Nie po czony) i wy wietlane s  przyciski 
LINK TO EXISTING ACCOUNT (Po cz z istniej cym kontem) oraz 
SEND E-MAIL INVITATION TO PATIENT (Wy lij zaproszenie e-mail 
do pacjenta).

Pobieranie danych z konta z po czeniem            

W przypadku po czenia z kontem pacjenta w programie CareLink 
Personal wszelkie nowe dane z tego konta s  automatycznie wysy ane 
za ka dym razem, gdy profil pacjenta zostanie otwarty 
w oprogramowaniu CareLink Pro. 

UWAGA: Aby upewni
si , e to nast pi, nale y

przej  do zak adki
Tools > Options > General

(Narz dzia > Opcje >
Ogólne) i sprawdzi , czy
opcja „Synchronize with

Medtronic CareLink
Personal” (Synchronizuj

z Medtronic CareLink
Personal) jest

zaznaczona.

Za ka dym razem, gdy w dowolnym momencie po otwarciu profilu 
pacjenta maj  zosta  pobrane dane pacjenta z programu CareLink 
Personal, nale y wykona  nast puj ce czynno ci:

1 Upewni  si , e obszar roboczy Profile (Profil) jest otwarty, 
a komputer jest pod czony do Internetu.

2 Wybra  opcj Tools > Synchronize Patient Data (Narz dzia > 
Synchronizuj dane pacjenta).

Ikona synchronizacji w zak adce pacjenta obraca si . Zatrzymanie si
ikony oznacza uko czenie procesu.

UWAGA: Je eli pacjent
nie chce ju

udost pnia  swoich
danych z programu
CareLink Personal,

mo e wy czy  t  opcj
w menu OPTIONS.

Zostanie wy wietlony
komunikat

informacyjny.

3 Wszelkie dodatkowe dane pobrane z programu CareLink Personal 
poka  si  na raporcie pacjenta. 

Ikona synchronizacji
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Ustawienia sprz towe 5
Zawarto  rozdzia u
• Przed rozpocz ciem: strona 30
• Pod czanie urz dze : strona 31

W tym rozdziale znajduj  si  ilustracje pokazuj ce, w jaki sposób ustawi
urz dzenie pacjenta, aby komputer móg  odczytywa  z niego dane.

Aby odczyta  dane bezpo rednio z urz dzenia pacjenta, lekarz musi 
mie  do niego dost p. Mo na jednak odczyta  dane urz dzenia z konta 

pacjenta w programie CareLink™ Personal bez konieczno ci odczytywania 
ich bezpo rednio z urz dzenia pacjenta.   

Przed rozpocz ciem

Aby odczyta  dane bezpo rednio z urz dzenia, nale y mie
urz dzenie pacjenta wraz z wszelkimi kablami lub urz dzeniami 
komunikacyjnymi niezb dnymi do przes ania danych do komputera.
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Pod czanie urz dze

UWAGA: Szczegó owe
informacje s  podane

w instrukcjach
wy wietlanych przez

oprogramowanie
CareLink™ Pro podczas
odczytywania urz dze .

Ogólny sposób ustawiania urz dze  w celu uzyskania komunikacji 
z komputerem jest przedstawiony na rysunku pogl dowym. Na 
pozosta ych ilustracjach przedstawiono konkretne aspekty komunikacji 
z urz dzeniami. 

UWAGA: Na tym
przyk adzie pokazano,

jak za pomoc
urz dzenia CareLink

USB komputer
komunikuje

si z pomp .

Rysunek pogl dowy ustawienia sprz tu               

TM

CareLinkUSB

CareLink USB

Komputer

Pompa Paradigm
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Ilustracje pod czenia sprz tu                                    

                      

Po czenia z komputerem

port
USB

port
szeregowy
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do
pod czenia

do portu
szeregowego

w komputerze

urz dzenie ComLink do u ytku z pomp  z serii Paradigm

Elementy opcjonalne

urz dzenie Com-Station do u ytku z pompami MiniMed 508 i jako 
urz dzenie przej ciowe dla glukometru
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Obszar roboczy Devices 
(Urz dzenia) 6
Zawarto  rozdzia u
• Przed rozpocz ciem: strona 35
• Dodawanie urz dzenia: strona 35
• Ustawianie urz dzenia aktywnym lub nieaktywnym: strona 40 
• Odczytywanie danych z urz dzenia: strona 41

Informacje wymagane do odczytania urz dzenia pacjenta (marka, 
model, numer seryjny itp.) s  przechowywane w obszarze roboczym 
Devices (Urz dzenia). Dlatego te  nie trzeba ich podawa  za ka dym 
razem, gdy dane s  odczytywane z urz dzenia. 

Urz dzenia w obszarze roboczym Devices (Urz dzenia) s
przechowywane na jednej z dwóch list — Active Devices (Urz dzenia 
aktywne) lub Inactive Devices (Urz dzenia nieaktywne). Po dodaniu 
urz dzenie jest automatycznie umieszczane na li cie Active Devices
(Urz dzenia aktywne). Mo na odczytywa  dane wy cznie z urz dze  na 
li cie Active Devices (Urz dzenia aktywne). B d  to prawdopodobnie 
urz dzenia wykorzystywane aktualnie przez pacjenta. 

Inne urz dzenia nale ce do pacjenta, ale nie b d ce aktualnie 
w u yciu, mo na przechowywa  na li cie Inactive Devices (Urz dzenia
nieaktywne). W ten sposób informacje s  przechowywane w pliku. 
Te urz dzenia mo na uaktywni  w dowolnym momencie.
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Przed rozpocz ciem

Aby otworzy  obszar roboczy Devices (Urz dzenia) dla pacjenta, 
pacjent musi posiada  profil zapisany w systemie. Patrz Rozdzia 4, 
Obszar roboczy Profile (Profil).

Aby doda  urz dzenie lub bezpo rednio odczyta  z niego dane, 
urz dzenie musi utrzymywa  komunikacj  z komputerem. Wi cej
informacji na temat ustawiania komunikacji pomi dzy urz dzeniami 
a komputerem znajduje si  w cz ci Rozdzia 5, Ustawienia sprz towe.

Dodawanie urz dzenia

W przypadku urz dzenia, które nie zosta o jeszcze dodane, mo na 
uzyska  dane z konta pacjenta w programie CareLink Personal. 
Takie urz dzenia zostan  automatycznie dodane, gdy dane zostan
zsynchronizowane pomi dzy programem CareLink Personal 
a oprogramowaniem CareLink Pro.

UWAGA: Tylko jedna
pompa mo e by

aktywna na jednego
pacjenta. Dodanie nowej

pompy spowoduje
przeniesienie istniej cej

pompy na list
nieaktywn .

Dodawanie pompy firmy Medtronic lub monitora Guardian          

1 Upewni  si , e dodawane urz dzenie jest ustawione do komunikacji 
z komputerem. (Informacje na temat etapów po czenia mo na 
znale  w cz ci Rozdzia 5, Ustawienia sprz towe).

2 Klikn  zak adk  pacjenta lub dwukrotnie klikn  jego nazwisko 
w tabeli Patient Lookup (Wyszukiwanie pacjenta).

3 Nacisn  przycisk DEVICES (Urz dzenia) w celu przej cia do obszaru 
roboczego Devices (Urz dzenia) pacjenta (patrz przyk ad, strona 11).

4 Nacisn  przycisk ADD DEVICE (Dodaj urz dzenie).

5 Wybra  opcj Medtronic Pump/Guardian (Pompa firmy 
Medtronic/monitor Guardian). Zostanie wy wietlony kreator Add Medtronic 
Pump/Guardian (Dodawanie pompy firmy Medtronic/monitora Guardian).

Przycisk DEVICES
(Urz dzenia)
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UWAGA: Model pompy
jest wy wietlany z ty u
pompy lub na ekranie

stanu pompy.

6 Wybra  przycisk opcji w celu okre lenia dodawanego urz dzenia. 

W przypadku wybrania opcji MiniMed 508 pump (Pompa MiniMed 508) 
nale y przej  do punktu 9.

7 Nacisn  przycisk NEXT (Dalej). Zostanie wy wietlona strona Serial
Number (Numer seryjny).

UWAGA: Je eli nie
zostanie wprowadzony

prawid owy numer
seryjny, wy wietlany

zostanie komunikat
o b dzie. Nale y

sprawdzi  przyk ady na
tej stronie i upewni  si ,

e wprowadzane s
prawid owe znaki

podane z ty u pompy.
Je eli jest to konieczne,

nale y wpisa  sze
znaków ponownie.

8 Korzystaj c z przyk adów na tej stronie, znale  sze cioznakowy 
numer seryjny na dodawanym urz dzeniu. (Je eli wymagana jest 
pomoc w lokalizacji numeru, nale y nacisn  opcj >> learn more
(dowiedz si  wi cej)). Wpisa  sze  znaków w polu Device Serial 
Number (Numer seryjny urz dzenia).

9 Nacisn  przycisk NEXT (Dalej). Wy wietlona zostanie strona 
Communication Options (Opcje komunikacji) podobna do 
przedstawionej poni ej.
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10 Nacisn  menu rozwijane Choose Port (Wybierz port), a nast pnie
wybra  port, za pomoc  którego urz dzenie ComLink, Paradigm Link®,
CareLink USB lub Com-Station czy si  z komputerem. W przypadku 
braku pewno ci co do wyboru portu nale y wybra  opcj Auto Detect 
(or USB) (Automatyczne wykrywanie lub USB). 

11 Nacisn  przycisk NEXT (Dalej). Wy wietlana jest strona Test Connection
(Sprawdzanie po czenia), podobna do przedstawionej poni ej.

12 Post powa  zgodnie z instrukcjami i nacisn  przycisk TEST.

Wy wietlany jest komunikat informuj cy o tym, czy po czenie by o
udane. Je eli tak, nale y przej  do nast pnego punktu. 

UWAGA: W tym te cie
nie s  odczytywane

dane z pompy, ale jest
sprawdzana poprawna
komunikacja pomi dzy
pomp  a komputerem.

Je eli nie, nale y upewni  si , e sprz t pomi dzy urz dzeniem 
a komputerem jest prawid owo pod czony. Nale y równie  nacisn
przycisk BACK (Wstecz) na stronach kreatora w celu upewnienia si ,
e wprowadzone dane urz dzenia s  poprawne.

13 Nacisn  przycisk DONE (Gotowe).

Pompa zosta a dodana do listy Active Devices (Urz dzenia aktywne) 
pacjenta.
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Dodawanie glukometru            

1 Klikn  zak adk  pacjenta lub dwukrotnie klikn  jego nazwisko 
w tabeli Patient Lookup (Wyszukiwanie pacjenta).

2 Upewni  si , e dodawany glukometr utrzymuje komunikacj
z komputerem. (Informacje na temat etapów po czenia mo na 
znale  w cz ci Rozdzia 5, Ustawienia sprz towe).

3 Nacisn  przycisk DEVICES (Urz dzenia) w celi przej cia do obszaru 
roboczego Devices (Urz dzenia) pacjenta (patrz przyk ad, strona 11).

4 Nacisn  przycisk ADD DEVICE (Dodaj urz dzenie).

5 Wybra  opcj Blood Glucose Meter (Glukometr). Wy wietlony zostanie 
kreator Add Blood Glucose Meter (Dodawanie glukometru).

6 Nacisn  przycisk opcji w celu wybrania prawid owej marki glukometru.

7 Nacisn  przycisk NEXT (Dalej). Wy wietlona zostanie strona Meter 
Model (Model glukometru, strona ta ró ni si  w zale no ci od 
producenta glukometru).

8 Nacisn  odpowiedni model glukometru w celu jego dodania. 
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9 Nacisn  przycisk NEXT (Dalej). Wy wietlona zostanie strona 
Communication Options (Opcje komunikacji).

UWAGA: Mo na
wybiera  jedynie

spo ród tych opcji,
które obowi zuj  dla

dodawanego
glukometru.

10 Nacisn  menu rozwijane Choose Port (Wybierz port), a nast pnie 
wybra  port, za pomoc  którego urz dzenie ComLink, Paradigm Link®

lub CareLink USB czy si  z komputerem. W przypadku braku 
pewno ci co do wyboru portu nale y wybra  opcj Auto Detect
(Automatyczne wykrywanie). 

11 Nacisn  przycisk NEXT (Dalej). Wy wietlona zostanie strona 
Test Connection (Sprawdzanie po czenia).

12 Post powa  zgodnie z instrukcjami podanymi dla glukometru 
i nacisn  przycisk TEST.

Wy wietlany jest komunikat informuj cy o tym, czy po czenie by o
udane. Je eli tak, nale y przej  do nast pnego punktu. 

Je eli nie, nale y upewni  si , e sprz t pomi dzy urz dzeniem 
a komputerem jest prawid owo pod czony. Nale y równie  nacisn
przycisk BACK (Wstecz) w kreatorze w celu upewnienia si , e
wprowadzone dane s  poprawne.



Podr cznik u ytkownika oprogramowania CareLink™ Pro    Obszar roboczy Devices (Urz dzenia)      40

13 Nacisn  przycisk DONE (Gotowe).

Glukometr zosta  dodany do listy Active Devices (Urz dzenia aktywne) 
pacjenta.

Ustawianie urz dzenia aktywnym lub nieaktywnym

Urz dzenia pacjenta mo na przenosi  pomi dzy list Active Devices
(Urz dzenia aktywne) a list Inactive Devices (Urz dzenia nieaktywne) 
zgodnie z potrzebami. Aby mo na by o odczyta  dane z urz dzenia, 
musi ono by  aktywne. 

Na li cie Active Devices (Urz dzenia aktywne) mo na mie  tyle 
glukometrów, ile jest potrzebne, ale tylko jedn  pomp . Przed 
dodaniem nowej pompy nale y upewni  si , e bie ca pompa 
ma zosta  dezaktywowana.

Dezaktywacja urz dzenia              

1 Klikn  zak adk  pacjenta lub dwukrotnie klikn  jego nazwisko 
w tabeli Patient Lookup (Wyszukiwanie pacjenta).

2 Nacisn  przycisk DEVICES (Urz dzenia) w celi przej cia do obszaru 
roboczego Devices (Urz dzenia) pacjenta.

UWAGA: Urz dzenia
mog  by  podane pod

równowa n  nazw
urz dzenia. Patrz
Odpowiedniki, na

stronie 5.

3 Nacisn  opcj >> make this device inactive (dezaktywuj to 
urz dzenie) pod urz dzeniem, które ma zosta  dezaktywowane.
Urz dzenie zostaje przeniesione na list Inactive Devices
(Urz dzenia nieaktywne).

Ponowna aktywacja urz dzenia               

1 Klikn  zak adk  pacjenta lub dwukrotnie klikn  jego nazwisko 
w tabeli Patient Lookup (Wyszukiwanie pacjenta).

2 Nacisn  przycisk DEVICES (Urz dzenia). Wy wietlony zostanie 
obszar roboczy Devices (Urz dzenia) pacjenta.

3 Nacisn  opcj >> activate this device (aktywuj to urz dzenie) pod 
urz dzeniem, które ma zosta  aktywowane.
Urz dzenie zostaje przeniesione na list Active Devices
(Urz dzenia aktywne).

Usuwanie urz dzenia             

W wyniku opisanych poni ej czynno ci urz dzenie zostanie usuni te 
z obszaru roboczego Devices (Urz dzenia) i systemu CareLink Pro:

1 Klikn  zak adk  pacjenta lub dwukrotnie klikn  jego nazwisko 
w tabeli Patient Lookup (Wyszukiwanie pacjenta).
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2 Nacisn  przycisk DEVICES (Urz dzenia) w celi przej cia do obszaru 
roboczego Devices (Urz dzenia) pacjenta.

3 Upewni  si , e urz dzenie znajduje si  na li cie Inactive Devices
(Urz dzenia nieaktywne). Je eli tak nie jest, nacisn  opcj
>> Inactivate this device (dezaktywuj to urz dzenie) pod jego 
bie c  pozycj .

4 Nacisn  opcj >> delete this device (usu  to urz dzenie)
pod urz dzeniem, które ma zosta  usuni te.

Wy wietlony zostanie komunikat ostrzegaj cy, e urz dzenie 
i wszystkie jego dane zostan  usuni te z rekordu pacjenta.

5 Nacisn  przycisk YES (Tak) w celu usuni cia urz dzenia.

Urz dzenie i jego dane zosta y usuni te z obszary roboczego Devices
i z systemu CareLink Pro. Dane z tego urz dzenia nie b d  ju  dost pne 
do u ytku w raportach.

Odczytywanie danych z urz dzenia

Jednym sposobem pobrania danych z urz dzenia jest po czenie
si z istniej cym kontem pacjenta w programie CareLink Personal. 
(Patrz Tworzenie po cze  z kontami programu CareLink Personal 
(opcjonalne), na stronie 26). Innym sposobem jest odczytanie ich 
bezpo rednio z urz dzenia, co opisano w niniejszym rozdziale. 

Dane z urz dzenia pacjenta mog  zosta  odczytane przez oprogramowanie 
CareLink Pro, je eli urz dzenie znajduje si  na li cie Active Devices
(Urz dzenia aktywne) i utrzymuje komunikacj  z komputerem. Po pobraniu 
tych danych mo na ich u y  do utworzenia raportów pomagaj cych 
w oszacowaniu zarz dzania terapi  pacjenta. (Wi cej informacji na temat 
raportów mo na znale  w cz ci Rozdzia 7, Obszar roboczy Reports 
(Raporty)).

Poni ej zosta y zebrane niektóre rodzaje informacji zbierane przez 
system CareLink Pro z pompy insulinowej podczas pobierania:  

• ró ne ustawienia na pompie, takie jak tryb powiadamiania, 
g o no d wi ku i wy wietlanie godziny

• podane dawki podstawowe insuliny
• zdarzenia bolusa i podane dawki
• wpisy kalkulatora Bolus Wizard
• ilo ci wype nienia
• okresy zawieszenia
• odczyty czujnika glukozy za pewien okres dla pomp wyposa onych

w czujnik
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System mo e równie  zbiera  dane z systemów Guardian REAL-Time 
obejmuj ce:

• odczyty czujnika glukozy (SG)
• warto ci wspó czynnika czujnika
• wspó czynniki kalibracji czujnika
• znaczniki posi ku
• wstrzykni cia insuliny

Ponadto podczas odczytywania urz dzenia do systemu mo na pobra
ró ne informacje zapisane w glukometrze. 

OSTRZE ENIE: Nale y anulowa  lub zako czy  wszystkie tymczasowe wlewy podstawowe 
lub aktywne bolusy i wyczy ci  wszelkie aktywne alarmy. Pompa zostanie zawieszona na 
czas odczytu. Po zako czeniu odczytu nale y upewni  si , e pompa wznowi a prac .

PRZESTROGA: Podczas odczytu pompy nie nale y korzysta  z pilota pompy. 

Je li bateria pompy jest niemal zupe nie roz adowana, pompa nie b dzie przesy a  danych 
do komputera. Je eli stan wskazuje na niski poziom mocy w baterii, nale y j  wymieni .    

1 Klikn  zak adk  pacjenta lub dwukrotnie klikn  jego nazwisko 
w tabeli Patient Lookup (Wyszukiwanie pacjenta).

2 Upewni  si , e urz dzenie pacjenta utrzymuje komunikacj
z komputerem. (Patrz Rozdzia 5, Ustawienia sprz towe).

3 Nacisn  przycisk DEVICES (Urz dzenia) w celu przej cia do 
obszaru roboczego Devices (Urz dzenia) pacjenta.

UWAGA: Urz dzenia
mog  by  podane pod

równowa n  nazw
urz dzenia. Patrz
Odpowiedniki, na

stronie 5.

4 Na li cie Active Devices (Urz dzenia aktywne) znale  urz dzenie, 
z którego maj  zosta  pobrane dane i upewni  si , e dane w opcji 
Choose port (Wybierz port) s  poprawne.

– W przypadku pomp nacisn  menu rozwijane Amount of Data
(Ilo  danych) i wybra  ilo  danych do odczytu przez 
oprogramowanie CareLink Pro.

5 Nacisn  powi zany przycisk READ DEVICE (Odczytaj urz dzenie).

6 Post powa  zgodnie z instrukcjami dla danego urz dzenia i nacisn
przycisk OK.

7 W oprogramowaniu CareLink Pro wy wietlany jest pasek post pu, 
ukazuj cy stopie  uko czenia odczytu urz dzenia.
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8 W przypadku klikni cia przycisku CANCEL (Anuluj) w trakcie odczytu 
urz dzenia wy wietlony zostanie komunikat ostrzegaj cy, e anulowanie 
dzia ania mo e doprowadzi  do utraty wszystkich danych odczytanych 
do tej pory. Aby ponownie uruchomi  pobieranie, nale y nacisn
przycisk READ DEVICE (krok 5).

– Aby anulowa , nacisn  przycisk YES (Tak). 
– Aby kontynuowa  odczytywanie danych z urz dzenia, nacisn

przycisk NO (Nie).

Gdy system zako czy odczytywanie danych z urz dzenia, wy wietlony
zostanie komunikat potwierdzaj cy zako czenie odczytu.

9 Nacisn  przycisk OK. 

– W przypadku pomp post powa  zgodnie z instrukcjami dotycz cymi 
wyprowadzenia ich z trybu zawieszenia.

Je eli oprogramowanie CareLink Pro nie mo e pobra  danych 
z urz dzenia, wi cej informacji mo na znale  w cz ci Rozdzia 9, 
Rozwi zywanie problemów.
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Obszar roboczy Reports 
(Raporty) 7
Zawarto  rozdzia u
• Przed rozpocz ciem: strona 44
• Tworzenie raportów: strona 45
• Informacje o raportach: strona 53
• Eksportowanie danych: strona 55

Obszar roboczy Reports (Raporty) oprogramowania CareLink™ Pro 
pozwala na przekszta cenie danych uzyskanych z urz dzenia 
w informacje u yteczne klinicznie. Rodzaje raportów, które mo na 
utworzy , s  opisane w cz ci Informacje o raportach, na stronie 53.

Raporty mog  by  tworzone na ekranie, wysy ane bezpo rednio 
do drukarki albo zapisywane jako pliki TIFF lub PDF, które mo na 
do czy  do elektronicznej dokumentacji medycznej (ang. EMR, 
Electronic Medical Record). Za pomoc  jednej czynno ci mo na 
utworzy  kilka rodzajów raportów.

Dane wy wietlane na tych raportach s  pobierane z urz dze  pacjenta, 
z konta pacjenta w programie CareLink Personal lub z obu tych róde .

Przed rozpocz ciem

Je eli w raporcie ma zosta  przedstawiony pewien okres, istnieje 
potrzeba posiadania danych z urz dzenia z tego okresu. Mo e równie
zaj  potrzeba pod czenia urz dzenia pacjenta do komputera w celu 
uzyskania bie cych danych  przed utworzeniem raportów.

Przed utworzeniem raportu nale y zapozna  si  z punktem Verify Report 
Settings (Sprawd  ustawienia raportu). W tym punkcie mo na dok adnie 
ustawi  raport w taki sposób, aby pobrane zosta y po dane dane.
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Tworzenie raportów

W sekcjach poni ej opisano czynno ci zwi zane z tworzeniem jednego 
lub wi cej raportów.

Otwieranie obszaru roboczego Reports (Raporty)      

1 Nacisn  zak adk  pacjenta lub nacisn  przycisk OPEN PATIENT 
(Otwórz rekord pacjenta) i dwukrotnie nacisn  nazwisko pacjenta.

Wy wietlony zostanie obszar roboczy Reports (Raporty, patrz przyk ad, 
strona 11).

UWAGA: Aby upewni
si , e posiadane

s najnowsze dane
urz dzenia z konta

pacjenta w programie
CareLink Personal,

nale y nacisn  przycisk
SYNC DATA

(Synchronizacja
danych).

Wybór okresu przedstawianego w raporcie        

1 Aby zmieni  okres przedstawiony w raporcie(-tach), nacisn  menu 
rozwijane Duration (Czas trwania) i wybra  okres. (Maksymalny czas 
trwania wynosi 12 tygodni).

2 Daty rozpocz cia i zako czenia s  ustawiane automatycznie, chyba e
wybrana zostanie opcja custom date range (niestandardowy zakres daty). 

UWAGA: W przypadku
wybrania zakresu daty

d u szego ni  dozwolony
wy wietlony zostanie
komunikat o b dzie.

Nale y wówczas zmieni
czas trwania lub daty.

Je eli po dany jest niestandardowy zakres daty, nale y nacisn
menu rozwijane From (Od) lub Through (Do) i wybra  po dany 
miesi c, dat  lub rok. 

Kalendarz danych

Obszar kalendarza danych obszaru roboczego Reports (Raporty) 
zawiera trzymiesi czne okno podawanych informacji. Podane s
w nim urz dzenia i ilo  danych urz dzenia zawarta w wybranych 
trzech miesi cach. Jest w nim równie  pokazany czas trwania okresu 
przedstawionego w raporcie dla wybranych trzech miesi cy. 

Przycisk Open Patient
(Otwórz rekord pacjenta)

dane urz dzenia
okres przedstawiany 
w raporcie

kalendarz danych
miesi ce
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Je eli dane urz dzenia i okres przedstawiony w raporcie zachodz  na 
siebie, oznacza to, e dla cz ci lub ca o ci wy wietlanego okresu 
przedstawionego w raporcie posiadane s  dane.

Na obszarze kalendarza danych s  pocz tkowo wy wietlane dane 
z ostatnich trzech miesi cy. Aby zobaczy  inne miesi ce, nale y
nacisn  przyciski strza ek na jednym z ko ców wy wietlanych miesi cy.

Wybieranie ród a danych do przedstawienia       

1 Je eli pacjent korzysta z glukometru cz cego si  z pomp , wybra
jedn  z poni szych opcji podawania danych glukometru w raporcie za 
pomoc  naci ni cia: 
– in the pump (w pompie): Zalet  tej opcji jest to, e dane nale y

odczyta  wy cznie z pompy pacjenta, przy czym pompa dodaje do 
odczytów z glukometru informacje o czasie wyst pienia, a odczyty 
s  bezpo rednio powi zane z wykorzystywanymi obliczeniami 
kalkulatora Bolus Wizard. Wad  jest to, e je eli wyst puj  trudno ci
w komunikacji pomi dzy pomp  a po czonym glukometrem, 
odczyty z glukometru dla tego okresu czasu mog  nie zosta
podane. W przypadku pomp MiniMed Paradigm przed modelem 
522/722 równie  wszelkie odczyty glukometru z oblicze  kalkulatora 
Bolus Wizard, które nie zostan  wykorzystane, nie s  podawane.

– in the link meter(s) (w po czonym glukometrze(-ach)): Zalet  tej opcji 
jest podawanie w raporcie wszystkich odczytów przechowywanych 
w po czonym glukometrze. Wad  jest to, i  w celu skorelowania 
danych z glukometru i pompy nale y upewni  si , e zegary pompy 
i glukometru zosta y ze sob  zsynchronizowane. Dane z pompy 
i po czonego glukometru musz  by  równie  odczytane oddzielnie.

2 Aby doda  dane z urz dzenia do raportu, nale y zaznaczy  pole 
wyboru obok odpowiedniego urz dzenia. 

Nie mo na doda  urz dze  wykluczonych podczas wyboru dokonanego 
w punkcie 1. Aby to zmieni , nale y wybra  inn  opcj  po czonego 
glukometru.

Zachodzenie na siebie danych 
urz dzenia i okresu 

przedstawionego w raporcie

przyciski strza ek
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3 Aby wykluczy  dane urz dzenia z raportów, nale y odznaczy  pole 
wyboru obok odpowiedniego urz dzenia. 

Nie mo na zmieni  znaczników wyboru zwi zanych z opcj  wybran
w punkcie 1. Aby je zmieni , nale y wybra  inn  opcj  po czonego 
glukometru.

Sprawdzanie danych urz dzenia        

1 W obszarze kalendarza danych obszaru roboczego Reports (Raporty) 
nale y sprawdzi , czy okres przedstawiony w raporcie zachodzi na 
dane urz dzenia (patrz przyk ad, strona 46).

2 Je eli paski zachodz  na siebie przez ca y okres przedstawiany 
w raporcie(-tach), dane dla raportu s  dost pne. Mo na nacisn
przycisk NEXT (Dalej) i przej  do cz ci Sprawdzanie ustawie
raportów, na stronie 49.

3 Je eli paski nie nak adaj  si  na siebie lub nak adaj  si
w niewystarczaj cym stopniu, mo na wykona  kilka czynno ci:

– Zmieni  okres przedstawiany w raporcie (patrz Wybór okresu 
przedstawianego w raporcie, na stronie 45).

– Pobra  dodatkowe dane urz dzenia (patrz Pobieranie 
dodatkowych danych urz dzenia, na stronie 47).

Pobieranie dodatkowych danych urz dzenia        

1 Aby pobra  wi cej danych z urz dzenia, nacisn  przycisk READ 
DEVICE (Odczytaj urz dzenie) powi zany z urz dzeniem.

Wy wietlony zostanie pasek odczytywania urz dzenia.

OSTRZE ENIE: Nale y anulowa  lub zako czy  wszystkie tymczasowe wlewy podstawowe 
lub aktywne bolusy i wyczy ci  wszelkie aktywne alarmy. Pompa zostanie zawieszona na 
czas odczytu. Po zako czeniu odczytu nale y upewni  si , e pompa wznowi a prac .

pasek READ DEVICE (Odczytaj urz dzenie)

przycisk READ DEVICE 
(Odczytaj urz dzenie)
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PRZESTROGA: Podczas odczytu pompy nie nale y korzysta  z pilota pompy. 

Je li bateria pompy jest niemal zupe nie roz adowana, pompa nie b dzie przesy a  danych 
do komputera. Je eli ekran stanu urz dzenia wskazuje na niski poziom mocy w baterii, 
nale y j  wymieni .    

2 Sprawdzi , czy dane w polu Choose port (Wybierz port) s  poprawne 
dla tego urz dzenia. 

Aby zmieni  to ustawienie, nale y nacisn  menu rozwijane dla tego 
pola i wybra  inne ustawienie.

3 Upewni  si , e urz dzenie jest pod czone do komputera. 

4 Je eli urz dzenie jest pomp , mo na okre li  ilo  danych do pobrania. 
Nale y nacisn  menu rozwijane Amount of Data (Ilo  danych) 
i okre li  ilo .

UWAGA: W przypadku
wybrania opcji All

available data
(Wszystkie dost pne

dane) system pobierze
wszystkie dane

w pompie. W wyniku
tego dzia ania wszystkie

istniej ce podwójne
dane w systemie

zostan  nadpisane.

5 Nacisn  przycisk READ DEVICE (Odczytaj urz dzenie). Nale y
dok adnie przeczyta  wy wietlany komunikat, poniewa  zawiera 
on precyzyjne instrukcje dotycz ce odczytania pompy.

6 Post powa  zgodnie z instrukcjami i nacisn  przycisk OK. 

Wy wietlony zostanie pasek odczytywania urz dzenia.

Mo na anulowa  odczytywanie w dowolnym momencie poprzez 
naci ni cie przycisku CANCEL (Anuluj).

Wy wietlony zostanie komunikat potwierdzaj cy zako czenie odczytu.

7 Nacisn  przycisk OK.

Dane urz dzenia b d  teraz widoczne w ramach kalendarza danych.

8 Nacisn  przycisk NEXT (Dalej) na górze obszaru roboczego Reports
(Raporty).

Wy wietlony zostanie krok Verify Report Settings (Sprawd
ustawienia raportów). Pozwala to upewni  si  przed utworzeniem 
raportu(-ów), e ustawienia dla tego pacjenta s  poprawne.
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Sprawdzanie ustawie  raportów           

1 Upewni  si , e ustawienia Glucose Target (Docelowe st enie 
glukozy) maj dane warto ci. Nale y wpisa  te warto ci lub 
nacisn  strza ki w gór  lub w dó  w polach Low (Niskie) i High
(Wysokie) w celu zwi kszenia lub zmniejszenia warto ci.

UWAGA: Mo e
wyst powa  do pi ciu

okresów posi ków.
Warto ci domy lne to
Breakfast ( niadanie),

Lunch (Obiad) i Dinner
(Kolacja).

2 Aby doda  okres posi ku, nacisn  przycisk ADD MEAL (Dodaj posi ek). 
Aby dokona  edycji istniej cego okresu posi ku, nale y nacisn  dowolne 
miejsce na obszarze jednego z posi ków na linii czasowej.

Zostanie uaktywniony edytor okresów posi ków znajduj cy si  pod 
lini  czasow .

3 Wprowadzi  tekst lub nacisn  strza ki w celu wybrania po danych 
ustawie .

UWAGA: Je eli te
ustawienia maj  zosta

u yte wy cznie dla tego
posi ku, nale y

odznaczy  pole wyboru
obok opcji Use these

parameters for all of this
patient’s meals (U yj tych

ustawie  dla wszystkich
posi ków pacjenta).

– Meal Name (Nazwa posi ku): nazwa, która ma zosta  przypisana 
do okresu posi ku.

– Meal Time Period (Okres czasu posi ku): godziny, pomi dzy
którymi ma miejsce posi ek.

– Pre-Meal BG Target (mg/dl or mmol/l) (Docelowe st enie 
glukozy przed posi kiem, mg/dl lub mmol/l): dolna i górna granica 
docelowego zakresu st enia glukozy pacjenta przed posi kiem.

linia
czasowa

okres posi ku

pola do edycji okresów posi ków

okresy k adzenia si  spa  i pobudki
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– Pre-Meal Analysis Period: okres, przez który b dzie analizowana 
glukoza, przed rozpocz ciem posi ku. Odczyty glukozy zebrane 
w tym czasie s  wykorzystywane do szczegó owej analizy w raporcie.

– Post-Meal BG Target (mg/dL or mmol/L) (Docelowe st enie 
glukozy po posi ku, mg/dl lub mmol/l): dolna i górna granica 
docelowego zakresu st enia glukozy pacjenta po posi ku.

– Post-Meal Analysis Period: okres, przez który b dzie analizowana 
glukoza, po posi ku. Odczyty glukozy zebrane w tym czasie s
wykorzystywane do szczegó owej analizy w raporcie.

UWAGA: Okresy
posi ków nie mog  na
siebie zachodzi , ale

linie pocz tkowe
i ko cowe mog  ze

sob  graniczy . Okresy
posi ków musz  mie
co najmniej 60 minut

d ugo ci.

Mo na zmieni  d ugo  istniej cego okresu posi ku lub pobudki i k adzenia 
si  spa , naciskaj c na uchwyt na pocz tku lub ko cu i przeci gaj c
go, a nast pnie upuszczaj c w innym miejscu na linii czasowej. 

4 Aby u y  ustawie  z tego posi ku do wszystkich innych posi ków 
pacjenta, nale y upewni  si , e pole wyboru obok opcji Use these 
parameters for all of this patient’s meals (U yj tych ustawie  dla 
wszystkich posi ków pacjenta) jest zaznaczone.

5 Po zako czeniu tworzenia lub edycji okresu posi ku nacisn  przycisk 
SAVE (Zapisz).

6 Aby usun  okres posi ku, nacisn  przycisk DELETE MEAL (Usu
posi ek). Po pytaniu o potwierdzenie nacisn  przycisk DELETE (Usu ).

7 Oprogramowanie CareLink Pro mo e zapami ta  te ustawienia dla 
tego pacjenta do nast pnego razu, gdy b dzie dla niego tworzony 
raport. Aby zapisa  ustawienia dla tego pacjenta, nacisn  przycisk 
SAVE SETTINGS (Zapisz ustawienia).

wybra  uchwyt na pocz tku lub ko cu, przeci gn  i upu ci  go w innym 
miejscu na linii czasowej

linia czasowa

znaczniki odczytywania urz dzenia
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8 Nacisn  przycisk NEXT (Dalej) na górze obszaru roboczego Reports
(Raporty).

Jest to etap Select and Generate Reports (Wybieranie i tworzenie 
raportów) procesu. Jest w nim podana lista rodzajów raportów, a tak e
tabela danych pomagaj ca wybra , czy w czy  czy wykluczy  pewne 
dni danych z raportu(-ów) Daily Details (Szczegó y z dnia). 

9 Aby wydrukowa  ekran, nale y nacisn  ikon  PRINT (Drukuj).

UWAGA: Aby zmieni
wy wietlanie tabeli

danych, nale y
nacisn  opcj

>> customize columns
(dostosuj kolumny).
Patrz Preferencje na

karcie Report Generation
(Tworzenie raportu), na

stronie 22.

Wybór rodzajów raportów i dat do przedstawienia w raporcie           

1 Zaznaczy  pole wyboru obok raportu(-ów), który ma zosta  w czony
do zestawu raportów.

2 Je eli podczas tego okresu przedstawianego w raporcie dane zosta y
odczytane z pompy lub monitora Guardian wi cej ni  raz, mo e istnie
wiele przegl dów danych z urz dzenia: 

a. Nale y upewni  si , e pole wyboru obok opcji Device Settings 
Snapshot (Przegl d ustawie  urz dzenia) jest zaznaczone. 

b. Nacisn  rozwijan  strza k  i wybra  dat  i godzin  dla danych
danych. 

– Pumps: Wybra  przegl d danych z pompy pacjenta.
– Guardian: Wybra  przegl d danych z monitora Guardian pacjenta. 

Je eli jakie  pole jest zaciemnione, dla okresu przedstawianego 
w raporcie nie ma dost pnych danych.

Tabela danych

ikona
drukowania
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3 Przewin  tabel  danych w celu przejrzenia dost pnych informacji 
raportu Daily Detail (Szczegó y z dnia). 

– Mo na sortowa  dane w ka dej kolumnie. Naci ni cie nag ówka
kolumny spowoduje posortowanie danych w kolejno ci rosn cej. 
Ponowne naci ni cie nag ówka spowoduje posortowanie danych 
w kolejno ci malej cej.

UWAGA: Je eli dla
jakiej  daty nie ma

adnych danych, daty
tej nie mo na wybra .

4 Zaznaczy  pole wyboru w wierszach tabeli danych dla ka dej daty, dla 
której ma zosta  utworzony raport Daily Detail (Szczegó y z dnia). 

– Aby za pomoc  jednego klikni cia w czy  lub wykluczy  wszystkie 
daty raportów Daily Detail (Szczegó y z dnia), nale y zaznaczy  pole 
wyboru na górze kolumny pól wyboru tabeli danych.

Tworzenie raportów                                  

1 Po sprawdzeniu wyborów dotycz cych tworzenia raportów nacisn
przycisk GENERATE REPORTS (Utwórz raporty) na górze obszaru 
roboczego Reports (Raporty).

Wy wietlona zostanie lista opcji.

2 Wybra  opcj  w celu podgl du (preview), drukowania (print) lub 
zapisania (save) raportu(-ów).

W przypadku wybrania opcji Preview (Podgl d) wy wietlone zostanie 
okno Report Preview (Podgl d raportu).

3 Za pomoc  strza ek porusza  si  po raportach wielostronicowych.

4 Nacisn  jeden z pozosta ych przycisków na górze okna Report 
Preview (Podgl d raportu) w celu zapisania lub wydrukowania 
raportu(-ów).

5 Aby zamkn  to okno, nale y nacisn  przycisk CLOSE (Zamknij) 
w prawym górnym rogu okna.Przycisk CLOSE

(Zamknij)
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Informacje o raportach         

W tej sekcji znajduje si  opis ka dego raportu. Wi cej szczegó ów
dotycz cych sk adników raportów, a tak e przyk adowe raporty, 
znajduj  si  w Podr czniku dotycz cym raportów. Dost p do 
Podr cznika dotycz cego raportów mo na uzyska  poprzez 
oprogramowanie CareLink Pro:

1 Help > View Report Reference Guide (PDF) (Pomoc > Wy wietl
Podr cznik dotycz cy raportów). 

2 Wybra  j zyk dla Podr cznika dotycz cego raportów.

Raporty oprogramowania CareLink Pro maj  nast puj ce wspólne 
elementy: 

• Nag ówek raportu — nag ówek raportu zawiera informacje 
identyfikacyjne, takie jak nazwa raportu, nazwisko pacjenta 
i ród o danych.

• St enie w glowodanów i glukozy we krwi — Na wykresach 
i w tabelach jednostki w glowodanów s  wy wietlane kursyw
a st enie glukozy we krwi jest pogrubione.

• Dane z weekendu — dni weekendu s  pogrubione, aby mo na je 
by o atwo zidentyfikowa .

• Legendy — na dole ka dego raportu pojawia si  legenda symboli. 
Chocia  symbol mo e pojawia  si  w kilku raportach, legenda jest 
specyficzna dla ka dego raportu.

Raport Adherence (Zachowanie)        

W tym raporcie przedstawione s  dane opisuj ce sposób wykorzystania 
pomp insulinowych i czujników, a tak e zachowanie pacjenta pod 
wzgl dem terapii. Raport ten odpowiada na pytanie „Czy ilo  danych 
by a wystarczaj ca do dok adnego okre lenia w jaki sposób pacjent 
korzysta ze swojej pompy insulinowej i czujnika, je eli by y one 
stosowane?”, a tak e na pytanie „Czy pacjent stosuje si  do instrukcji 
dotycz cych terapii?” Raport ten wskazuje równie , czy zachodzi 
potrzeba przeprowadzenia z pacjentem rozmowy na temat sposobu 
kontroli cukrzycy przez pacjenta.

Raport Sensor and Meter Overview (Informacje ogólne na temat 
czujnika i glukometru)        

Raport Sensor and Meter Overview (Informacje ogólne na temat 
czujnika i glukometru) przedstawia w postaci graficznej dzienne 
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warto ci st enia glukozy i warto ci rednich pochodz ce z glukometru 
pacjenta, w cznie z rozbiciem na godziny w trybie 24-godzinnym 
i informacjami na temat tego, w jaki sposób odnosz  si  one do 
posi ków i wzorców snu. Znajduj  si  w nim równie  statystyki 
odczytów st enia glukozy i wykorzystania insuliny. 

Je eli dost pne s  dane z czujnika, podobna analiza danych z czujnika 
jest tworzona jako pierwsza strona tego raportu. Je eli dane z czujnika 
nie s  dost pne, jako pierwsza strona zostanie utworzona strona analizy 
danych z glukometru.

Ostatnia strona(-y) raportu przedstawia warto  st e  z dnia na dzie
i jako  kontroli glikemicznej, w glowodanowej i insulinowej pacjenta. 
Ka da strona pokazuje w jaki sposób ta kontrola ró ni si  podczas 
ka dego dnia w ca ym okresie przedstawionym w raporcie, maksymalnie 
do 14 dni na stron .

Raport Logbook (Dzienniczek)        

Raport Logbook (Dzienniczek) przedstawia dane dotycz ce st enia 
glukozy z glukometru, w glowodanów i insuliny dla ka dego dnia 
w okresie przedstawionym w raporcie. Stanowi on dzienniczek zdarze
rejestrowanych co godzin , a tak e dziennych warto ci rednich i sum. 
Ka da strona zawiera do 14 dni. Je eli okres przedstawiony w raporcie 
przekracza 14 dni, tworzone s  dodatkowe strony.

Raport Device Settings Snapshot (Przegl d ustawie  urz dzenia)        

W tym raporcie przedstawiony jest przegl d ustawie  pompy lub monitora 
Guardian REAL-Time pacjenta dla konkretnej daty i godziny. Mo e on 
pomóc w zrozumieniu innych raportów lub po prostu udokumentowa
ustawienia pacjenta. 

Ustawienia pompy lub monitora s  rejestrowane wy cznie, gdy urz dzenie
jest odczytywane. Je eli urz dzenie nie by o odczytywane w okresie 
przedstawionym w raporcie, nie b d  dost pne adne ustawienia.

Raport Daily Detail (Szczegó y z dnia)        

Raport Daily Detail (Szczegó y z dnia) przedstawia dane dotycz ce 
st enia glukozy, ilo ci w glowodanów i wykorzystanie insuliny przez 
pacjenta w wybranym dniu. Dla ka dego dnia wybranego z tabeli 
danych tworzony jest oddzielny raport.
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Raport Daily Detail (Szczegó y z dnia) umo liwia szczegó owy wgl d
w ka dy wybrany dzie . Pozwala on równie  skupi  si  na konkretnym 
dniu w przypadku przeczucia, e w terapii pacjenta nast pi y interesuj ce
wydarzenia.

Eksportowanie danych

Mo na eksportowa  dane urz dzenia zebrane i przechowywane 
w oprogramowaniu CareLink Pro. W ten sposób dostarczane s
wszystkie dane z urz dzenia pacjenta do u ycia w statystykach lub 
do tworzenia wyspecjalizowanych raportów lub tabeli. Plik .csv mo na 
zaimportowa  do programu Microsoft Excel lub pewnych klinicznych 
programów statystycznych, w których mo na dalej przetwarza  dane.

Plik .csv zawiera dane, w których zarejestrowane s  dzia ania urz dzenia. 
S  tam podane np. listy z zapisami odczytów glukometru, warto ciami
odczytów z glukometru otrzymanymi przez pomp  lub zmianami 
w dawce podstawowej.

UWAGA: Jest to
zaawansowana funkcja

wymagaj ca znajomo ci
surowych danych

urz dzenia. Wymaga
ona równie  bieg o ci

w pos ugiwaniu si
oprogramowaniem, do
którego importowany

jest plik .csv.

Aby skorzysta  z funkcji eksportowania oprogramowania CareLink Pro, 
nale y wykona  nast puj ce czynno ci:

1 Nacisn  zak adk  pacjenta lub nacisn  przycisk OPEN PATIENT 
(Otwórz rekord pacjenta) i dwukrotnie nacisn  nazwisko pacjenta.

2 Upewni  si , e wy wietlany jest obszar roboczy Reports (Raporty).

3 Za pomoc  pól Duration (Czas trwania) lub From/Through (Od/do) 
ustawi  daty i d ugo  raportu.

Maksymalny czas trwania, który mo na wybra  to 12 tygodni.

4 Nacisn cze export selected data (eksportuj wybrane dane).

Wy wietlone zostanie okno dialogowe Export Data to CSV File
(Eksportuj dane do pliku CSV).

cze export 
selected data 
(eksportuj
wybrane dane)
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5 Aby zmieni  miejsce przechowywania pliku .csv na komputerze, nacisn
strza k  na prawo od pola Save in (Zapisz w) i wybra  miejsce.

6 Je eli ma zosta  zmieniona nazwa pliku, wpisa  j  w polu File name
(Nazwa pliku).

7 Nacisn  przycisk SAVE (Zapisz).

UWAGA: Wi cej
informacji na temat

danych w plikach CSV
mo na znale  w cz ci
Dane CSV, na stronie 67.

Plik .csv zosta  zapisany na komputerze w wybranym miejscu. Mo na
teraz importowa  go do dowolnego programu obs uguj cego ten 
rodzaj plików.
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Administracja systemem 8
Zawarto  rozdzia u
• Przed rozpocz ciem: strona 57
• Stosowanie aktualizacji oprogramowania: strona 58
• Tworzenie kopii zapasowej i przywracanie bazy danych: strona 59

Wa ne jest, aby regularnie tworzy  kopi  zapasow  bazy danych 
oprogramowania CareLink™ Pro. W bazie danych przechowywane 
s wszystkie dane systemowe zgromadzone w rekordach pacjenta, 

cznie z informacjami o profilu, danymi pobranymi z urz dzenia 
i ustawieniami raportów. 

Oprogramowanie CareLink Pro umo liwia zapisywanie kopii bazy 
danych i przywracanie ich.

Wa ne jest równie  posiadanie najnowszej wersji oprogramowania 
CareLink Pro. Zaktualizowane wersje s  dost pne okresowo i mog
zawiera  wa ne ulepszenia. Mo na wybra  pomi dzy wyszukiwaniem 
aktualizacji a byciem powiadamianym, gdy s  one dost pne.

Przed rozpocz ciem

Dobrym pomys em jest ustalenie regularnego rozk adu wykonywania 
kopii zapasowych bazy danych. Pomaga to w utrzymaniu regularno ci
tej czynno ci i zmniejsza ryzyko utracenia danych. 

Podczas tworzenia kopii zapasowej lub przywracania oprogramowanie 
CareLink Pro wykrywa innych u ytkowników mog cych korzysta
z tego oprogramowania na innych komputerach i oferuje im mo liwo
zapisania pracy. Mimo to do dobrej praktyki nale y wyszukanie innych 
u ytkowników przed rozpocz ciem jednego z tych procesów.
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Stosowanie aktualizacji oprogramowania

Automatyczne otrzymywanie aktualizacji

Co jaki  czas dost pne s  aktualizacje oprogramowania CareLink Pro. 
Po wy wietleniu powiadomienia o aktualizacji nale y wykona  opisane 
poni ej czynno ci w celu pobrania najnowszej wersji oprogramowania.

UWAGA: Zanim
aktualizacja

oprogramowania
zostanie zastosowana,
nale y wykona  kopi

zapasow  bazy danych.
Patrz Tworzenie kopii

zapasowej bazy danych,
na stronie 59.

1 Upewni  si , e na komputerze jest dost pne i aktywne po czenie 
z internetem.

2 Gdy dla oprogramowania CareLink Pro dost pna jest aktualizacja, 
wy wietlony zostanie komunikat o aktualizacji oprogramowania 
CareLink Pro. Pozwala to na pobranie aktualizacji.

3 Nacisn  przycisk DOWNLOAD (Pobieranie). (W przypadku naci ni cia
przycisku CANCEL (Anuluj), powiadomienie o aktualizacji zostanie 
zamkni te. Mo na pobra  aktualizacj  w pó niejszym terminie).

Wy wietlone zostanie ostrze enie zawieraj ce zalecenie utworzenia 
kopii zapasowej bazy danych.

4 Nacisn  przycisk YES (Tak) w celu utworzenia kopii zapasowej bazy 
danych (opis tej procedury znajduje si  w cz ci Tworzenie kopii 
zapasowej bazy danych, na stronie 59). Nacisn  przycisk NO (Nie), 
je eli nie ma zosta  utworzona kopia zapasowa danych.

Wy wietlony zostanie komunikat potwierdzaj cy, e pobrana zosta a
nowa wersja oprogramowania CareLink Pro.

5 Aby zacz  korzysta  z najnowszej wersji oprogramowania 
CareLink Pro, nacisn  przycisk YES (Tak) w celu zamkni cia
i ponownego otwarcia aplikacji. Nacisn  przycisk NO (Nie), je eli
przed ponownym uruchomieniem po dane jest zaczekanie 
CareLink Pro.

Wy czanie automatycznych aktualizacji

Je eli u ytkownik nie chce otrzymywa  powiadomie  o aktualizacjach 
oprogramowania CareLink Pro, powinien wykona  nast puj ce czynno ci:

1 Wybra  opcj Tools > Options (Narz dzia > Opcje).

2 Nacisn  zak adk General (Ogólne).

3 W sekcji Communications (Komunikacja) usun  zaznaczenie pola 
wyboru obok opcji Automatically check for software updates
(Automatycznie wyszukuj aktualizacje oprogramowania).
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R czne wyszukiwanie aktualizacji

W dowolnym momencie mo na r cznie wyszuka  aktualizacje 
CareLink Pro.

UWAGA: Zanim
aktualizacja

oprogramowania
zostanie zastosowana,
nale y wykona  kopi

zapasow  bazy danych.
Patrz Tworzenie kopii

zapasowej bazy danych,
na stronie 59.

1 Upewni  si , e na komputerze jest dost pne i aktywne po czenie 
z internetem.

2 Wybra  opcj Tools > Check for Software Updates (Narz dzia > 
Szukaj aktualizacji oprogramowania).

3 Je eli adne aktualizacje nie s  akurat dost pne, wy wietlony
zostanie komunikat. Je eli aktualizacja jest dost pna, zostanie 
wy wietlony komunikat o aktualizacji oprogramowania CareLink Pro. 

4 Wykona  procedur  opisan  w cz ci Automatyczne otrzymywanie 
aktualizacji, na stronie 58.

Tworzenie kopii zapasowej i przywracanie bazy 
danych

Tworzenie kopii zapasowej bazy danych     

Poni sze czynno ci umo liwiaj  utworzenie kopii zapasowej aktualnej 
bazy danych do wybranego miejsca.

1 Upewni  si , e wszystkie rekordy pacjentów s  zamkni te.

2 Wybra  opcj Tools > Backup Database (Narz dzia > Utwórz kopi
zapasow  bazy danych).

UWAGA: Kopi
zapasow  bazy danych

mo na zapisa  na
dysku sieciowym

lub na przeno nym
no niku danych

(p ycie DVD, p ycie CD,
dysku USB itp.).

3 Aby zapisa  kopi  zapasow  w innym miejscu na komputerze, nacisn
strza k  na prawo od pola Save in (Zapisz w) i wybra  nowe miejsce.

4 Je eli nazwa pliku kopii zapasowej ma zosta  zmieniona, nale y
wpisa  j  w polu File name (Nazwa pliku).

5 Nacisn  przycisk SAVE (Zapisz). Gdy baza danych jest zapisywana, 
wy wietlany jest pasek post pu.

Po zako czeniu zapisywania kopii zapasowej wy wietlony zostanie 
komunikat.

6 Nacisn  przycisk OK w celu zamkni cia komunikatu.
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Przywracanie bazy danych         

Je eli do aktualnej bazy danych nie mo na uzyska  dost pu lub z niej 
korzysta , mo e zaistnie  potrzeba jej zast pienia.

PRZESTROGA: W przypadku przywracania z kopii zapasowej wszystkie nowe dane 
utworzone od momentu powstania wybranej kopii zapasowej zostan  utracone.

Nast puj ce czynno ci pozwalaj  na wybranie kopii zapasowej 
przeznaczonej do zast pienia aktualnej bazy danych.

1 Upewni  si , e wszystkie rekordy pacjentów s  zamkni te.

2 Wybra  opcj Tools > Restore Database (Narz dzia > Przywró
baz  danych). 

3 Wybra  plik kopii zapasowej, który ma zosta  u yty do zast pienia 
aktualnej bazy danych (zazwyczaj najnowszy).

4 Nacisn  przycisk OPEN (Otwórz). Zostanie wy wietlony komunikat 
ostrzegawczy. Nacisn  przycisk OK.

5 Gdy baza danych jest przywracana, wy wietlany jest pasek post pu.

Po zako czeniu operacji przywracania bazy danych wy wietlony
zostanie komunikat.

6 Nacisn  przycisk OK w celu zamkni cia komunikatu.

Gdy system jest niedost pny                

W przypadku próby uruchomienia systemu, gdy inny u ytkownik 
wykonuje operacj  tworzenia kopii zapasowej lub przywracania, zostanie 
wy wietlony komunikat informuj cy o niedost pno ci systemu. Do chwili 
zako czenia zadania system b dzie niedost pny.

Nale y wykona  jedn  z poni szych czynno ci:

• Poczeka  na zako czenie procesu i udost pnienie systemu.
• Nacisn  przycisk CANCEL (Anuluj) w celu wyj cia i spróbowa

pó niej.
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Rozwi zywanie
problemów 9
Zawarto  rozdzia u
• B dy zwi zane z ogólnym korzystaniem z aplikacji: strona 61
• B dy odczytu urz dzenia: strona 62
• B dy podczas tworzenia raportu: strona 64
• B dy tworzenia kopii zapasowej i przywracania systemu: strona 65
• Odinstalowanie oprogramowania: strona 65

Ten rozdzia  zawiera informacje maj ce na celu pomoc w rozwi zywaniu 
problemów, które mog  wyst pi  podczas korzystania z oprogramowania 

CareLink™ Pro. Zawiera on równie  instrukcje dotycz ce odinstalowania 
oprogramowania CareLink Pro, na wypadek gdyby zasz a taka potrzeba.

B dy zwi zane z ogólnym korzystaniem z aplikacji

Uprawnienia do pobierania aktualizacji oprogramowania przez Internet

Je eli u ytkownik spróbuje pobra  aktualizacj  oprogramowania przez 
internet, mo e otrzyma  komunikat o niewystarczaj cych do tego 
uprawnieniach. Do pobierania aktualizacji oprogramowania 
CareLink Pro wymagane s  uprawnienia administratora.

1 Nale y zamkn  aplikacj  oprogramowania CareLink Pro i uruchomi
komputer ponownie. 

2 Osoba z uprawnieniami administratora powinna zalogowa  si  na 
komputerze.

3 Nale y post powa  zgodnie z instrukcjami w cz ci Stosowanie 
aktualizacji oprogramowania, na stronie 58.
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Brak po czenia z baz  danych

Komunikat o b dzie mówi cy o braku po czenia z baz  danych 
oznacza jedn  z nast puj cych rzeczy:

• Baza danych zosta a przeniesiona. Baza danych musi znajdowa  si
w tym samym miejscu, które zosta o wybrane podczas instalacji 
oprogramowania CareLink Pro. Je eli zosta a ona przeniesiona, nale y
przemie ci  j  z powrotem w miejsce wybrane podczas instalacji.

• U ytkownik nie jest pod czony do dysku sieciowego, na którym 
znajduje si  baza danych. Je eli baza danych znajduje si  na dysku 
sieciowym, w sieci mog  wyst powa  problemy uniemo liwiaj ce 
dost p do dysku. Nale y skontaktowa  si  z dzia em obs ugi
komputerów w danej placówce w celu uzyskania pomocy w ponownym 
pod czeniu dysku sieciowego, na którym znajduje si  baza. 

Zapomniano has o placówki do oprogramowania CareLink Pro

Je eli nikt nie pami ta has a u ywanego w zak adzie opieki zdrowotnej 
do logowania do oprogramowania CareLink Pro, oprogramowanie 
CareLink Pro musi zosta  zainstalowane ponownie i musi zosta
utworzona nowa baza danych. Po ponownym zainstalowaniu 
oprogramowania nie b dzie mo na uzyska  dost pu do informacji 
o pacjentach znajduj cych si  w poprzedniej bazie danych. Has o
utworzone podczas nowej instalacji nale y zachowa , aby w przysz o ci
nie utraci  danych. 

B dy odczytu urz dzenia

B d odczytu urz dzenia Obja nienie

The selected serial port could 
not be opened. Another 
operation might be in progress 
on that port. Please wait until 
the port is available, or select 
another port (Nie mo na by o
otworzy  wybranego portu 
szeregowego. Inne dzia anie 
na tym porcie mo e by  w toku. 
Nale y poczeka , a port 
b dzie dost pny, lub wybra
inny port).

Nale y sprawdzi , czy wybrany port COM nie jest 
wykorzystywany przez inny program lub wybra  inny 
port. Nale y spróbowa  ponownie uruchomi
wykorzystywany komputer, a nast pnie ponownie 
odczyta  urz dzenie. Sprz t (kable itp.) pod czony 
do portu lub sam port mo e by  uszkodzony. Nale y
pod czy  sprz t do innego portu i spróbowa
odczyta  urz dzenie ponownie w celu okre lenia 
problemu. 
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Auto Detect could not find the 
device on any available port. 
Please check the cable 
connection, device battery 
& status and try again, or 
try specifying a serial port 
(Automatyczne wykrywanie nie 
znalaz o urz dzenia w adnym 
dost pnym porcie. Nale y
sprawdzi  pod czenie kabla, 
bateri  i stan urz dzenia 
i spróbowa  ponownie, lub 
spróbowa  poda  port 
szeregowy).

Nale y sprawdzi  po czenie pomi dzy kablem 
a komputerem, a nast pnie sprawdzi , czy stan 
baterii urz dzenia jest dobry. Je eli tak jest, nale y
spróbowa  poda  port szeregowy komputera, do 
którego pod czony jest kabel, zamiast wybiera
automatyczne wykrywanie.

Device not found at selected 
serial port. Please check the 
cable connection, device 
battery & status and try again, 
try selecting a different port, or 
try to Auto Detect the device 
(Nie znaleziono urz dzenia 
w wybranym porcie szeregowym. 
Nale y sprawdzi  pod czenie 
kabla, bateri  i stan urz dzenia 
i spróbowa  ponownie, 
spróbowa  wybra  inny port 
lub spróbowa  skorzysta
z automatycznego wykrywania).

Nale y sprawdzi  po czenie pomi dzy kablem 
a komputerem, a nast pnie sprawdzi , czy stan 
baterii urz dzenia jest dobry. Je eli tak jest, nale y
spróbowa  wybra  inny numer portu szeregowego 
komputera lub wybra  opcj  automatycznego 
wykrywania.

Unable to communicate with 
the device. Please ensure 
you’ve attached and selected 
the correct device, check the 
cable connection, device 
battery and status, and try 
again (Nie mo na skomunikowa
si  z urz dzeniem. Nale y
upewni  si , e zosta o
pod czone i wybrane 
prawid owe urz dzenie, 
sprawdzi  pod czenie kabla, 
bateri  i stan urz dzenia, 
a nast pnie spróbowa
ponownie).

Nale y sprawdzi  wszystkie ustawienia wybrane 
dla odczytywanego urz dzenia, w cznie z nazw
urz dzenia, numerem seryjnym i rodzajem 
po czenia. Nale y równie  upewni  si , e
urz dzenie, kabel i komputer s  prawid owo 
po czone. Nale y sprawdzi , czy stan baterii 
i alarmu urz dzenia jest prawid owy. Nast pnie 
spróbowa  odczytu ponownie.

Unexpected response… 
retrying (n%) 
(Nieoczekiwana odpowied …
ponowna próba w toku).

Z urz dzenia zosta a odczytana nieoczekiwana 
warto . System b dzie próbowa  komunikacji 
ponownie do momentu anulowania lub wyst pienia 
udanej komunikacji.

The communication device was 
found, but the pump (<serial #>) 
is not responding. Please verify 
the pump’s serial number, 
place the pump closer to the 
communication device to 
minimize interference, check 
pump battery and status 
(Urz dzenie komunikacyjne 
zosta o znalezione, ale pompa 
(<nr seryjny>) nie odpowiada. 
Nale y sprawdzi  numer 
seryjny pompy, umie ci
pomp  bli ej urz dzenia 
komunikacyjnego w celu 
zmniejszenia zak óce ,
sprawdzi  bateri  i stan pompy).

Nale y sprawdzi , czy zosta  wpisany prawid owy
numer seryjny pompy. Je eli nie, nale y ponownie 
wprowadzi  prawid owy numer seryjny. Je eli numer 
seryjny jest prawid owy, nale y spróbowa  przenie
pomp  bli ej do urz dzenia komunikacyjnego, 
umie ci  urz dzenie komunikacyjne i pomp  z dala 
od mo liwych zak óce  (takich jak inne urz dzenia 
o cz stotliwo ci radiowej) lub sprawdzi  bateri
pompy i stan podawania.

B d odczytu urz dzenia Obja nienie
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B dy podczas tworzenia raportu

Wiele wpisów danych dla tej samej daty

Je eli wiele wpisów danych istnieje dla tego samego dnia i godziny dla 
tego samego urz dzenia, system traktuje to jak konflikt i nie mo e go 
rozwi za . Raporty utworzone za pomoc  tych danych urz dzenia 
omin  porcj  danych, która si  nak ada. 

Mo na spróbowa  dostosowa  okres przedstawiany w raporcie w celu 
omini cia nak adaj cych si  danych. Mo na te  usun  urz dzenie 
z systemu, a nast pnie doda  je z powrotem w celu usuni cia
poprzednich odczytów.

System zamierza zignorowa  dane

Je eli w urz dzeniu zosta  zmieniony czas, co spowodowa o nak adanie 
si  danych lub przerwy w danych o d ugo ci trzech godzin lub wi cej,
system nie w czy tej porcji danych do tworzonych raportów.

This pump is delivering a temp 
basal. Please cancel the temp 
basal or wait until it completes, 
and then try again (Pompa 
podaje tymczasow  dawk
podstawow . Nale y anulowa
tymczasow  dawk  podstawow
lub poczeka , dopóki nie 
zostanie ona zako czona,
a nast pnie spróbowa
ponownie).

Pompa, któr  próbuje odczyta  u ytkownik,
podaje tymczasow  dawk  podstawow . Nale y
poczeka , a  tymczasowa dawka podstawowa 
zostanie zako czona, lub anulowa  tymczasow
dawk  podstawow  i wówczas odczyta  pomp .

This pump has active errors or 
alarms. Please clear the alarms 
and try again (W pompie 
zosta y uaktywnione alarmy 
lub wykryte b dy. Nale y
skasowa  alarmy i spróbowa
ponownie).

W pompie zosta y uaktywnione alarmy, które 
uniemo liwiaj  jej odczyt. Nale y przeczyta
instrukcje dotycz ce alarmów w celu ich skasowania. 
Nale y skasowa  alarm i ponowi  prób  odczytania 
pompy.

This pump is delivering a bolus. 
Please cancel the bolus or wait 
until it completes, and then try 
again (Pompa podaje bolus. 
Nale y anulowa  bolus lub 
poczeka , dopóki nie zostanie 
on zako czony, a nast pnie 
spróbowa  ponownie).

Pompa, któr  próbuje odczyta  u ytkownik, podaje 
bolus. Nale y poczeka , a  bolus zostanie zako czony,
lub anulowa  bolus i wówczas odczyta  pomp .

The device returned invalid 
entries; all data read will be 
discarded (Urz dzenie zwróci o
nieprawid owe wpisy; wszystkie 
odczytane dane zostan
odrzucone).

Nale y si  skontaktowa  z regionalnym 
przedstawicielem (patrz Pomoc techniczna, 
na stronie 3).

B d odczytu urz dzenia Obja nienie
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B dy tworzenia kopii zapasowej i przywracania 
systemu

Nie mo na zablokowa  bazy danych

Oznacza to, e system jest wykorzystywany przez wielu u ytkowników 
i inni u ytkownicy s  zalogowani. System nie pozwoli na utworzenie 
kopii zapasowej bazy danych, gdy inni u ytkownicy wykonuj
potencjalnie zadania mog ce mie  wp yw na baz  danych. Gdy 
wszyscy inni u ytkownicy zaprzestan  korzystania z oprogramowania 
CareLink Pro, mo na b dzie wykona  kopi  zapasow  bazy danych.

Tworzenie kopii zapasowej lub przywracanie systemu nie ko czy si

Inni u ytkownicy nie mog  si  zalogowa  i nie mo na zako czy
tworzenia kopii zapasowej lub przywracania systemu. Nale y
skontaktowa  si  z lini  pomocy lub lokalnym przedstawicielem firmy 
(patrz Pomoc techniczna, na stronie 3).

Przywracanie bazy danych nie uda o si

Plik kopii zapasowej bazy danych, którego u ytkownik próbuje u y  do 
przywrócenia systemu jest uszkodzony. Nale y spróbowa  przywróci
system z innego pliku kopii zapasowej.

Odinstalowanie oprogramowania

Je eli zachodzi potrzeba odinstalowania oprogramowania 
CareLink Pro, nale y wykona  nast puj ce czynno ci:

1 Otworzy Panel sterowania przez menu Start systemu Windows.

2 Wybra  opcj Dodaj lub usu  programy. Wy wietlone zostanie okno 
Dodaj lub usu  programy systemu Windows.

3 Przewin  do programu Medtronic Carelink Pro i nacisn  go.

4 Nacisn  przycisk REMOVE (Usu ). Wy wietlone zostanie okno 
kreatora InstallShield.

5 Nacisn  przycisk NEXT (Dalej). Wy wietlony zostanie komunikat 
z pro b  o potwierdzenie ch ci usuni cia aplikacji.

6 Nacisn  YES (Tak). Odinstalowanie programu zostanie uruchomione 
i usunie program i wszystkie jego pliki z komputera. Gdy to nast pi, na 
ekranie kreatora zostanie wy wietlony komunikat potwierdzaj cy 
odinstalowanie.

7 Nacisn  przycisk FINISH (Koniec).
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Tabela symboli
W poni szej tabeli przedstawiono ikony i symbole u ywane na 
opakowaniach i urz dzeniach:

Opis Ikona

Jedna sztuka na pojemnik/opakowanie (1x)

Uwaga: zapozna  si  z instrukcj
u ytkowania

Do czony dysk CD

Do czone wa ne dokumenty

Numer katalogowy REF

Znak CE przyznany przez odpowiedni
jednostk  notyfikowan  dla wyrobów 
medycznych
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D
od

at
ek

 A

Dane CSV A

W tym dodatku opisane s  dane oprogramowania CareLink™ Pro 
widziane po wyeksportowaniu do formatu CSV. 

Definicje kolumny danych

Nag ówek kolumny Definicja

Index (Indeks) Kolejno , w której dane zosta y zarejestrowane 
przez urz dzenie.

Date (Data) Data zarejestrowania danych przez urz dzenie.

Time (Godzina) Godzina zarejestrowania danych.

New Device Time 
(Nowa godzina urz dzenia)

Nowa data i godzina, je eli zosta y one zmienione 
w urz dzeniu.

BG Reading 
(Odczyt st enia glukozy, 
mg/dl lub mmol/l)

Odczyt st enia glukozy zarejestrowany przez 
glukometr monitor Guardian lub pomp . Je eli 
dane pochodz  z pompy lub monitora Guardian, 
ta kolumna odzwierciedla r czne st enie glukozy 
i st enie glukozy otrzymane z glukometru Link. 

Linked BG Meter ID 
(Identyfikator po czonego
glukometru)

Numer seryjny glukometru wysy aj cego konkretne 
odczyty st enia glukozy we krwi do urz dzenia.

Basal Rate 
(Szybko  dawki podstawowej, 
jedn./godz.)

Aktywna pr dko  podstawowego wlewu insuliny 
w jednostkach na godzin .

Temp Basal Amount 
(Ilo  tymczasowej dawki 
podstawowej) 

Je eli pompa podawa a tymczasow  dawk
podstawow , jest to ilo  podstawowej dawki 
podstawowej. 

Temp Basal Type (Rodzaj 
tymczasowej dawki podst.)

Rodzaj regulacji tymczasowej dawki podstawowej 
(pr dko  insuliny lub procent dawki podstawowej).

Temp Basal Duration 
(Czas trwania tymczasowej 
dawki podstawowej, min.)

D ugo  czasu w minutach dla podawania 
tymczasowej dawki podstawowej insuliny 
(patrz opis rodzaju powy ej).

Bolus Type 
(Rodzaj bolusa)

Rodzaj podawania insuliny w bolusie [Normal — 
normalny, Square — przed u ony, Dual (normal 
part) — z o ony (cz  normalna) lub Dual (square 
part) — z o ony (cz  przed u ona)].

Bolus Volume Selected 
(Wybrana obj to  bolusa, jedn.)

Ilo  jednostek insuliny wybrana do podania 
podczas podawania insuliny w bolusie.
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Bolus Volume Delivered 
(Podana obj to  bolusa, jedn.)

Faktycznie podana ilo  jednostek insuliny podczas 
podawania insuliny w bolusie.

Programmed Bolus Duration 
(Zaprogramowany czas 
trwania bolusa, godz.)

Czas trwania dla bolusa o przed u onym dzia aniu 
lub przed u onej porcji bolusa z o onego.

Prime Type 
(Rodzaj wype niania)

R czny lub sta y. Rodzaj r czny jest wykorzystywany 
bezpo rednio po przewijaniu w celu wype nienia 
drenów zestawu infuzyjnego przed ich wprowadzeniem. 
Rodzaj sta y jest wykorzystywany po wprowadzeniu 
zestawu infuzyjnego do wype nienia mi kkiej kaniuli 
insulin  po wyj ciu ig y do wprowadzania.

Prime Volume Delivered 
(Podana obj to  wype nienia, 
jedn.)

Ilo  jednostek insuliny podana faktycznie do 
wype nienia.

Alarm Nazwa alarmu, który wyst pi .

Suspend (Zawieszenie) Okre la stan zawieszenia pompy.

Rewind (Przewi ) Data i godzina przewini cia urz dzenia.

BWZ Estimate 
(Szacowana warto
w kalkulatorze Bolus Wizard, 
jedn.)

Szacowana ilo  insuliny w bolusie obliczona za 
pomoc  kalkulatora Bolus Wizard w pompie Paradigm.

BWZ Target High BG 
(Docelowe wysokie st enie 
glukozy we krwi w kalkulatorze 
Bolus Wizard, mg/dl lub mmol/l)

Ustawienie górnej granicy zakresu docelowego 
st enia glukozy we krwi, u ywane przez funkcj
kalkulatora Bolus Wizard.

BWZ Target Low BG 
(Docelowe niskie st enie 
glukozy we krwi w kalkulatorze 
Bolus Wizard, mg/dl lub mmol/l)

Ustawienie dolnej granicy zakresu docelowego 
st enia glukozy we krwi, u ywane przez funkcj
kalkulatora Bolus Wizard.

BWZ Carb Ratio 
(Wspó czynnik w glowodanów 
w kalkulatorze Bolus Wizard)

Ustawienie dla stosunku insuliny do 
w glowodanów. Je eli jako jednostki 
wykorzystywane s  gramy, stosunek jest ilo ci
gramów, na któr  przypada jednostka insuliny. 
Je eli jako jednostki wykorzystywane s  wymienniki, 
stosunek jest ilo ci  jednostek insuliny u ywanych
do skompensowania jednego wymiennika.

BWZ Insulin Sensitivity 
(Wra liwo  na insulin
w kalkulatorze Bolus Wizard)

Ustawienie wra liwo ci na insulin . Wra liwo
na insulin  okre la, o ile poziom glukozy we krwi 
obni a si  w wyniku podania jednej jednostki 
insuliny. Jest to ustawiane u ywane przez 
funkcj kalkulatora Bolus Wizard.

BWZ Carb Input 
(Dane wej ciowe ilo ci
w glowodanów w kalkulatorze 
Bolus Wizard)

Ilo  w glowodanów wprowadzona do kalkulatora 
Bolus Wizard i u ywana do oszacowania bolusa.

BWZ BG Input (Dane 
wej ciowe st enia glukozy 
w kalkulatorze Bolus Wizard, 
mg/dl lub mmol/l)

Odczyt st enia glukozy wprowadzona do 
kalkulatora Bolus Wizard i u ywana do 
oszacowania bolusa.

BWZ Correction Estimate 
(Szacowana korekta 
w kalkulatorze Bolus Wizard, 
jedn.)

Jednostki insuliny w bolusie wymagana do korekty 
st enia glukozy we krwi, obliczona przez 
kalkulator Bolus Wizard.

BWZ Food Estimate 
(Szacowana ilo  przed 
posi kiem w kalkulatorze Bolus 
Wizard, jedn.)

Jednostki insuliny w bolusie wymagana do 
skompensowania oczekiwanego spo ycia ilo ci
w glowodanów, obliczona przez kalkulator 
Bolus Wizard.

Nag ówek kolumny Definicja
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Wi cej informacji o plikach CSV eksportowanych 
przez oprogramowanie CareLink Pro

Tytu  na górze pliku CSV zawiera nast puj ce informacje:

• nazwisko pacjenta
• list  wybranych urz dze  i ich numery seryjne
• wybrany zakres danych

Ka dy blok kolumn posiada tytu  zawieraj cy nast puj ce informacje:

• nazw  urz dzenia, do którego odnosi si  blok danych
• numer seryjny tego urz dzenia 

Je eli dane nie s  wy wietlane zgodnie z oczekiwaniami

Istnieje szereg ró nych czynników, z powodu których dane CSV mog
by  wy wietlane w sposób inny od oczekiwanego.

• Zmiany daty lub godziny w urz dzeniu mog  zmieni  sekwencj  lub 
spowodowa  wy wietlenie rekordów spoza wybranego zakresu dat.

• Je eli pomi dzy odczytami z urz dzenia wyst puje du a przerwa, 
dane dla tego urz dzenia mog  by  wy wietlane w wielu blokach.

BWZ Active Insulin 
(Aktywna insulina w kalkulatorze 
Bolus Wizard, jedn.)

Obliczona ilo  aktywnej insuliny pozosta a w ciele 
z poprzednio podanych dawek insuliny, wyst puj ca
podczas okre lania szacowanej ilo ci bolusa za 
pomoc  funkcji kalkulatora Bolus Wizard.

Sensor Calibration BG 
(St enie glukozy we krwi do 
kalibracji czujnika, mg/dl lub 
mmol/l)

Warto  st enia glukozy wykorzystywana do 
kalibracji czujnika, podawana w mg/dl lub mmol/l.

Sensor Glucose 
(St enie glukozy z czujnika, 
mg/dl lub mmol/l)

Warto  st enia glukozy zmierzonego przez sensor.

ISIG value (Warto  ISIG) Sygna y wej ciowe (ISIG) odczytywane z czujnika, 
mierzone w nanoamperach (nA).

Nag ówek kolumny Definicja
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S
ow

ni
k

S ownik

A
A1c  Hemoglobina glikowana.
Audio bolus  Pomp  mo na zaprogramowa  w taki sposób, aby 
u ytkownik s ysza  sygna  d wi kowy po wybraniu ilo ci insuliny 
w bolusie (np. 0,5 lub 1,0 jednostek) do podania. Jest to pomocne 
w sytuacjach, gdy ci ko jest zobaczy  przyciski na pompie.

B
Bolus Dual Wave® (Z o ony)  Kombinacja bolusa zwyk ego, 
podawanego natychmiast, oraz nast puj cego po nim bolusa 
o przed u onym dzia aniu. Cz  insuliny z bolusa o przed u onym 
dzia aniu jest podawana równomiernie w pewnym okresie.
Bolus ekspresowy  Metoda podawania dla dowolnego rodzaju bolusa 
za pomoc  przycisku ekspresowego na pompie.
Bolus korekcyjny  Ilo  insuliny potrzebna do zredukowania wysokiego 
st enia glukozy w celu przywrócenia zakresu docelowego.
Bolus podawany przed posi kiem  Dawka insuliny przyjmowana 
w celu skompensowania oczekiwanego wzrostu st enia glukozy we 
krwi po jedzeniu.
Bolus r czny  Opcja dost pna w menu BOLUS, gdy aktywny jest 
kalkulator Bolus Wizard. Jedna z metod zaprogramowania bolusa bez 
korzystania z funkcji kalkulatora Bolus Wizard. 

Bolus Square Wave® (o przed u onym dzia aniu)  Bolus podawany 
równomiernie w okresie ustalonym przez u ytkownika (od 30 minut do 
8 godzin). 

C
CareLink™ Personal Us uga online umo liwiaj ca zarz dzanie 
cukrzyc  przez internet.
Cz  bolusa o przed u onym dzia aniu (Pd)  Druga cz  bolusa 
z o onego. Cz  o przed u onym dzia aniu jest podawana równomiernie 
we wskazanym okresie, po podaniu cz ci NATYCHMIASTOWEJ.
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E
Easy Bolus™  Metoda podawania zwyk ego bolusa, korzystaj c
z przycisku Easy Bolus ( atwy bolus) na pompie.

F
Glukometr  urz dzenie medyczne s u ce do okre lania przybli onego 
st enia glukozy we krwi. Ma a kropla krwi jest umieszczana na 
jednorazowym pasku testowym, który glukometr odczytuje i wykorzystuje 
do obliczenia st enia glukozy we krwi. Glukometr wy wietla nast pnie 
st enie w mg/dl lub mmol/l. 
GLU St enie glukozy we krwi

H
HbA1c  Hemoglobina glikowana.
Hiperglikemia  Podniesione st enie glukozy we krwi, obserwowane 
w wyniku monitorowania st e  glukozy we krwi z lub bez cz ci lub 
wszystkich z nast puj cych objawów: nudno ci, wymiotów, zaburze
widzenia, bólu g owy, zaburze  pokarmowych, cz stego oddawania 
du ych ilo ci moczu oraz letargu. 
Hipoglikemia  Niskie st enie glukozy we krwi, obserwowane 
w wyniku monitorowania st e  glukozy we krwi z lub bez cz ci lub 
wszystkich z nast puj cych objawów: nadmiernego g odu, drgawek lub 
dr enia, pocenia si , „ta cz cego” widzenia, uczucia zawrotów g owy, 
bólu g owy, niewyra nego mówienia, nag ych waha  nastrojów lub 
zmian osobowo ci.

I
ID nadajn.  Numer seryjny aktualnie u ywanego nadajnika.
Insulina w bolusie  Dawka insuliny podana w celu skompensowania 
oczekiwanego wzrostu st enia glukozy we krwi (np. po posi ku lub 
przek sce) lub w celu obni enia wysokiego st enia do poziomu 
zakresu docelowego.

J
Jednostki w glowodanów Warto  posi ku wprowadzana do kalkulatora 
Bolus Wizard. Wprowadzana w gramach (w glowodanów) lub 
wymiennikach w glowodanowych.

K
Krok Zwi kszenie dawki insuliny u ywane przy podawaniu atwego bolusa.
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cze  S u y do w czania i konfiguracji opcji miernika umo liwiaj cej
odbieranie przez pomp  odczytów BG z miernika CONTOUR® LINK, 
OneTouch® UltraLink™ lub Paradigm Link®.
W tym systemie okre lenie to odnosi si  równie  do czy hipertekstowych. 
Po naci ni ciu na nie cze hipertekstowe powoduje przej cie do 
innego miejsca w systemie lub innej witryny internetowej.

M
Maksymalna dawka podstawowa insuliny  Maksymalna dawka 
insuliny, jak  pompa mo e poda  jednorazowo w ramach wlewu 
podstawowego (okre lana przez u ytkownika).
Maksymalny bolus  Maksymalna ilo  insuliny w bolusie, jak  pompa 
mo e poda  jednorazowo (okre lana przez u ytkownika).
μl mikrolitr

N
Niskie GLU  Pompa uruchomi alarm, je eli czujnik zasygnalizuje, e
st enie glukozy u ytkownika osi gn o ustawion  warto  lub spad o
poni ej. Istnieje mo liwo  w czania lub wy czania tej funkcji.

O
Opcja glukometru  Funkcja umo liwiaj ca pompie otrzymywanie 
odczytów st enia glukozy we krwi z po czonego glukometru.
Ostrze enie dot. zbiorniczka  Programowalne ostrze enie 
generuj ca powiadomienie, gdy w zbiorniczku pompy pozostanie 
okre lona liczba jednostek lub gdy do opró nienia zbiorniczka 
pozostanie okre lony czas.

P
Profil wlewu podstawowego  Wlew podstawowy z godzin  pocz tku 
i ko ca. W celu osi gni cia lepszej kontroli glukozy u ytkownik mo e
zaprogramowa  w pompie kilka ró nych profilów w 24-godzinnym 
okresie, przy czym ka dy profil mo e mie  inny wlew podstawowy.
Przesy anie  Proces przesy ania danych pompy lub glukometru na 
serwer oprogramowania CareLink™ Personal.
Przypomnienie o kalibracji  Ustawiona warto  funkcji „Przyp.o kal.” 
jest przedzia em czasu przed wyga ni ciem wa no ci aktualnej 
warto ci kalibracji, gdy u ytkownik yczy sobie, aby pompa przypomina a
o konieczno ci dokonania kalibracji, uruchamiaj c alarm „GLKM GLU O”. 
Na przyk ad: je li dla parametru „Przyp.o kal.” wybrano ustawienie 
wynosz ce dwie godziny, alarm „GLKM GLU O” nast pi dwie godziny 
przed momentem, w którym wymagana b dzie kalibracja.
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R
RF  Cz stotliwo  radiowa (ang. RF, Radio Frequency). 

S
Schemat A/B schemat wlewu podstawowego dostosowany do 
poziomów aktywno ci odbiegaj cych od typowego trybu ycia pacjenta. 
Takimi rodzajami aktywno ci mog  by  np. uprawianie sportu raz 
w tygodniu albo zmiana godzin snu na czas weekendu, przed u one 
okresy zwi kszonej lub zmniejszonej aktywno ci b d  miesi czka.
Schemat standardowy  Zwyk y wlew podstawowy, dostosowany do 
typowego trybu ycia pacjenta. Gdy funkcja Schematów jest wy czona, 
pompa dzia a zgodnie ze schematem standardowym (podstawowym).
Schematy wlewu podstawowego  U ytkownik mo e zaprogramowa
w pompie do trzech ró nych schematów wlewu podstawowego dla 
podawania podstawowej dawki insuliny: standardowy, A i B. Dla ka dego
schematu istnieje mo liwo  ustawienia do 48 wlewów podstawowych.
St enie insuliny  Si a lub rodzaj insuliny, któr  lekarz przepisa
u ytkownikowi. Ma ono wp yw na pr dko  podawania insuliny przez 
pomp . Je eli st enie insuliny u ytkownika ulegnie zmianie, schematy 
wlewu podstawowego i maksymaln  pr dko  bolusa i dawki podstawowej 
nale y przeprogramowa  w pompie.
Suspend (Zawieszenie)  Funkcja przerywaj ca ca kowicie podawanie 
insuliny. Powoduje anulowanie podawanie bolusa i/lub wype niania. 
Wlew podstawowy jest wstrzymywany do czasu wznowienia. 

redni obszar pod krzyw  (ang. Area Under the Curve, AUC)  Jest 
to rednia ilo  dla nara enia na hiperglikemi  lub hipoglikemi  przez 
czas transmisji czujnika.

T
Test A1c  Test hemoglobiny A1c, s u cy do interpretacji st enia glukozy 
we krwi w danym okresie.
Test HbA1c  Test hemoglobiny A1c, s u cy do interpretacji kontroli 
st enia glukozy we krwi w okresie 2 do 3 miesi cy.
Test ketonowy  Keton to produkt przemiany materii powstaj cy gdy 
organizm jest zmuszany do spalania t uszczu zamiast glukozy w celu 
uzyskania energii. Mo e to oznacza  brak insuliny w organizmie. Test 
ketonowy mierzy ilo  ketonu skoncentrowanego we krwi lub moczu.
Tym.  Tymczasowy.
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Tymczasowy wlew podstawowy  Tymczasowy jednorazowy wlew 
podstawowy insuliny o sprecyzowanej dawce i czasie trwania. 
Zaspokaja zapotrzebowanie na insulin  zwi zane ze szczególnymi 
rodzajami aktywno ci i stanami nie nale cymi do typowego trybu 
ycia pacjenta.

U
Urz dzenie CareLink™ USB Urz dzenie u ywane do przesy ania 
danych zapisanych w pompach insulinowych z serii Medtronic 
Diabetes Paradigm lub monitorze Guardian REAL-Time do 
oprogramowania CareLink™ za pomoc  portu USB komputera.
Urz dzenie Com-Station  Urz dzenie s u ce do pobierania danych 
z pompy MiniMed 508 i przesy ania danych z glukometrów firm trzecich 
do komputera.
Urz dzenie ComLink  Nadajnik-odbiornik o cz stotliwo ci radiowej 
s u cy do pobierania danych z pompy Paradigm lub systemu Guardian 
REAL-Time CGM do komputera.

W
Wlew podstawowy insuliny  Godzinna, ci g a infuzja insuliny 
podawana automatycznie przez pomp  insulinow  na podstawie 
zaprogramowanych profilów i spersonalizowanych pr dko ci
ustawionych w pompie. Pompa podaje dzienn  infuzj  insuliny, 
pokrywaj c  zazwyczaj zapotrzebowanie na insulin  „t a” podczas 
okresów na czczo (tzn. w nocy i pomi dzy posi kami).
Wlew podstawowy  Ustawienie pompy zapewniaj ce sta y wlew 
insuliny w celu utrzymania stabilnego st enia glukozy we krwi mi dzy
posi kami i w nocy. Wlew podstawowy imituje wytwarzanie insuliny 
przez trzustk , zaspokajaj c niezwi zane z posi kami zapotrzebowanie 
organizmu na insulin .
Wra liwo  na insulin Warto  w mg/dl (lub mmol/l), o jak  jedna 
jednostka insuliny obni a st enie glukozy we krwi. (Dane z kalkulatora 
Bolus Wizard).
Wspó czynnik bolusa korekcyjnego (Wspó czynnik wra liwo ci)  
Okre la, o ile 1,0 jednostka insuliny obni y st enie glukozy we krwi. 
Ten wspó czynnik u ywany jest do obliczania wielko ci bolusa 
korekcyjnego, gdy st enie cukru we krwi u ytkownika jest wysokie.
(st enie glukozy we krwi) – (docelowe st enie glukozy we krwi) = X. 
X ÷ (wspó czynnik bolusa korekcyjnego) = 
ilo  bolusa korekcyjnego
Wspó czynnik w glowodanów  Ilo  w glowodanów kompensowana 
przez jednostk  insuliny. (Patrz tak e stosunek wymienników).
Wspó czynnik wymienników  Ilo  insuliny potrzebna do 
skompensowania jednego (1) wymiennika w glowodanowego. 
(Patrz tak e stosunek w glowodanów).
WW  W glowodany
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Wysokie GLU  Pompa uruchomi alarm, je eli czujnik zasygnalizuje, 
e st enie glukozy u ytkownika osi gn o ustawion  warto  lub j

przekroczy o. Istnieje mo liwo  w czania lub wy czania tej funkcji.

Z
Zestaw infuzyjny  Narz dzia u ywane do wk adania i mocowania 
kaniuli pod skór  i dostarczania insuliny do miejsca wprowadzenia 
za pomoc  rurek od pompy.
Zwyk y bolus  Natychmiastowe podanie okre lonej liczby jednostek 
insuliny. 
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